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1. Copyright Notice

© Copyright 2023 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match
PANTONEéidentified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright ©1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.
Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, lllustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFl and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 - 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.
Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B - 9051 Gent

info.eur@esko.com

1.1. Third party license information

This product includes patented technology.

This product and use of this product is under license from Markzware
under U.S. Patent No. 5,963,641.

This product includes pugixml.
MIT License
Copyright (c) 2006-2022 Arseny Kapoulkine

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
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OTHER DEALINGS IN THE SOFTWARE.

This product includes Little CMS.

Little CMS
Copyright (c) 1998-2020 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject

to the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes zlib.
(C) 1995-2022 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

This product includes OpendJDK.
The GNU General Public License (GPL)
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it. By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users. This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it. (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.
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When we speak of free software, we are referring to freedom, not price. Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights. These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have. You must
make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software. If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License. The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or

translated into another language. (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
" "

you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope. The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

a) You must cause the modified files to carry prominent notices stating
that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or
in part contains or is derived from the Program or any part thereof, to be
licensed as a whole at no charge to all third parties under the terms of
this License.
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c) If the modified program normally reads commands interactively when run,
you must cause it, when started running for such interactive use in the
most ordinary way, to print or display an announcement including an
appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that users may redistribute
the program under these conditions, and telling the user how to view a copy
of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is
not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works. But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source
code, which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to
give any third party, for a charge no more than your cost of physically
performing source distribution, a complete machine-readable copy of the
corresponding source code, to be distributed under the terms of Sections 1
and 2 above on a medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to
distribute corresponding source code. (This alternative is allowed only
for noncommercial distribution and only if you received the program in
object code or executable form with such an offer, in accord with
Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it. For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable. However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License. Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works. These actions are prohibited by law if you do not
accept this License. Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
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do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein. You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License. If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices. Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded. In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the

General Public License from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

10
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12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

One line to give the program's name and a brief idea of what it does.
Copyright (C) <year> <name of author>

This program is free software; you can redistribute it and/or modify it
under the terms of the GNU General Public License as published by the Free
Software Foundation; either version 2 of the License, or (at your option)
any later version.

This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for
more details.

You should have received a copy of the GNU General Public License along
with this program; if not, write to the Free Software Foundation, Inc.,
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
with ABSOLUTELY NO WARRANTY; for details type 'show w'. This is free
software, and you are welcome to redistribute it under certain conditions;
type 'show c' for details.

The hypothetical commands 'show w' and 'show c¢' should show the appropriate
parts of the General Public License. Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary. Here
is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
'Gnomovision' (which makes passes at compilers) written by James Hacker.

signature of Ty Coon, 1 April 1989

Ty Coon, President of Vice
This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are

n
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subject to the following clarification and special exception to the GPL, but

only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

Linking this library statically or dynamically with other modules is making
a combined work based on this library. Thus, the terms and conditions of
the GNU General Public License cover the whole combination.

As a special exception, the copyright holders of this library give you
permission to link this library with independent modules to produce an
executable, regardless of the license terms of these independent modules,
and to copy and distribute the resulting executable under terms of your
choice, provided that you also meet, for each linked independent module,
the terms and conditions of the license of that module. An independent
module is a module which is not derived from or based on this library. If
you modify this library, you may extend this exception to your version of
the library, but you are not obligated to do so. If you do not wish to do
so, delete this exception statement from your version.

This product includes OpenJPEG.

The copyright in this software is being made available under the 2-clauses
BSD License, included below. This software may be subject to other third
party and contributor rights, including patent rights, and no such rights
are granted under this license.

Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
Copyright (c) 2002-2014, Professor Benoit Macqg

Copyright (c) 2003-2014, Antonin Descampe

Copyright (c) 2003-2009, Francois-Olivier Devaux

Copyright (c) 2005, Herve Drolon, Freelmage Team

Copyright (c) 2002-2003, Yannick Verschueren

Copyright (c) 2001-2003, David Janssens

Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
Copyright (c) 2012, CS Systemes d'Information, France

All rights reserved.

with or without
are permitted provided that the following conditions

Redistribution and use in source and binary forms,
modification,
are met:

1. Redistributions of source code must
notice, this list of conditions and
2. Redistributions in binary form must
notice, this list of conditions and

retain the above copyright

the following disclaimer.
reproduce the above copyright
the following disclaimer in the

documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

AND ANY EXPRESS OR IMPLIED WARRANTIES,

"AS IS'

INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

ARE DISCLAIMED. 1IN NO EVENT SHALL THE
LIABLE FOR ANY DIRECT, INDIRECT,
CONSEQUENTIAL DAMAGES
SUBSTITUTE GOODS OR SERVICES;
INTERRUPTION)
CONTRACT, STRICT LIABILITY, OR TORT

POSSIBILITY OF SUCH DAMAGE.

This product includes FreeType.

Portions of this software are copyright
Project (www.freetype.orq)
All rights reserved.

This product includes QtCopyDialog.

Copyright (c)
All rights reserved.

12

INCIDENTAL,
(INCLUDING, BUT NOT LIMITED TO,
LOSS OF USE,
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
(INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,

(C)
licensed under the Freetype License.

COPYRIGHT OWNER OR CONTRIBUTORS BE
SPECIAL, EXEMPLARY, OR
PROCUREMENT OF
DATA, OR PROFITS; OR BUSINESS

EVEN IF ADVISED OF THE

2014 The FreeType

2009 Nokia Corporation and/or its subsidiary(-ies) .
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BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

This product includes QtMigration.
Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are

met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

* Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
of its contributors may be used to endorse or promote products derived

from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

This product includes QtService.
Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are

met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

* Neither the name of Nokia Corporation and its Subsidiary(-ies) nor

the names of its contributors may be used to endorse or promote

products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes QtSingleApplication.

13
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Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

* Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes QtSql.
Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

This product includes svgio.

Copyright Oleg Maximenko 2014.
Distributed under the Boost Software License, Version 1.0.

This product includes xxHash.

xxHash Library
Copyright (c) 2012-2020 Yann Collet
All rights reserved.

BSD 2-Clause License (https://www.opensource.org/licenses/bsd-license.php)

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or
other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR

14
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ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes QtSvg.

The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and

its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR

ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE

OF THIS SOFTWARE.

This product includes appleseed.
The MIT License (MIT)

Copyright (c) 2010-2013 Francois Beaune, Jupiter Jazz Limited
Copyright (c) 2014-2019 The appleseedhg Organization

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

This product includes bcd.
Copyright (c) 2017 Malik Boughida and Tamy Boubekeur. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.
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2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You are under no obligation whatsoever to provide any bug fixes, patches, or
upgrades to the features, functionality or performance of the source code
("Enhancements") to anyone; however, if you choose to make your Enhancements
available either publicly, or directly to the authors of this software, without
imposing a separate written license agreement for such Enhancements, then you
hereby grant the following license: a non-exclusive, royalty-free perpetual
license to install, use, modify, prepare derivative works, incorporate into
other computer software, distribute, and sublicense such enhancements or
derivative works thereof, in binary and source code form.

This product includes glad.
The MIT License (MIT)
Copyright (c) 2013-2018 David Herberth

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

This product includes murmurhash3.
MurmurHash3 was written by Austin Appleby, and is placed in the public domain. The author
hereby disclaims copyright to this source code.

This product includes libxml2.
Copyright (C) 1998-2012 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
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NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library

Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev

All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

* The name of the author may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF

THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version: 7.0

Copyright (C) 1999-2007 Brian Paul All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS

OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
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EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved.

This software is based in part on the work of the Independent JPEG Group.

This product includes LibTIFF.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and

its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR

ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE

OF THIS SOFTWARE.

This product includes tesseract.

Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0

This product includes robin-map.
MIT License
Copyright (c) 2017 Tessil

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

This product includes cereal.

Copyright (c) 2013-2022, Randolph Voorhies, Shane Grant
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All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the copyright holder nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND

ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes curl.
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1996 - 2022, Daniel Stenberg, daniel@haxx.se, and many
contributors, see the THANKS file.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose
with or without fee is hereby granted, provided that the above copyright
notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not
be used in advertising or otherwise to promote the sale, use or other dealings
in this Software without prior written authorization of the copyright holder.

This product includes gSOAP.
EXHIBIT B.

Part of the software embedded in this product is gSOAP software.
Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
Genivia inc. All Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes XercesC.

NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
case for the Apache Xerces distribution.
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This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

Portions of this software were originally based on the following:
- software copyright (c) 1999, IBM Corporation., http://www.ibm.com.

This product includes 1llvm.

University of Illinois/NCSA
Open Source License

Copyright (c) 2003-2019 University of Illinois at Urbana-Champaign.
All rights reserved.

Developed by:
LLVM Team
University of Illinois at Urbana-Champaign
http://1lvm.org

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal with
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimers.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimers in the
documentation and/or other materials provided with the distribution.

* Neither the names of the LLVM Team, University of Illinois at
Urbana-Champaign, nor the names of its contributors may be used to
endorse or promote products derived from this Software without specific
prior written permission.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS WITH THE
SOFTWARE.

This product includes OpenSSL.
Copyright (c) 1998-2017 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without
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prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:
"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ~'AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. 1IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes OpenSSL.

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

1. Redistributions of source code must retain the copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:
"This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)"
The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from
the apps directory (application code) you must include an acknowledgement:
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "~ "AS IS'' AND

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

This product includes OpenlImageIO.

Copyright (c) 2008-present by Contributors to the OpenlmagelO project.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
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and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes lzw-ab.

Copyright (c) David Bryant
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of Conifer Software nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes 1z4.
Copyright (C) 20ll-present, Yann Collet.
BSD 2-Clause License (http://www.opensource.org/licenses/bsd-license.php)

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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This product includes XByak.

Copyright (c) 2007 MITSUNARI Shigeo
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

Neither the name of the copyright owner nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF

THE POSSIBILITY OF SUCH DAMAGE.
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This product includes ittnotify.

Copyright (c) 2011, Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
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FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes JBIG2Lib.
Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
This product includes ZXing C++ Library.

Copyright 2016 ZXing authors.
https://github.com/zxing

This product includes ICC Profiles.

Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
ColourKit Profiler Suite (www.colourprofiling.com)

This product includes ICC Profiles.

Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
This product includes ICC Profiles.

Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
This product includes ICC Profiles.

Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol (R) and
SWOP (R) are all registered trademarks of IDEAlliance (C).

This product includes PANTONE Color Libraries.

PANTONE® and other Pantone trademarks are the property of Pantone LLC.
Pantone is a wholly owned subsidiary of X-Rite, Incorporated.

This product includes PCRE.

Copyright (c) 1997-2016 University of Cambridge
All rights reserved.

Copyright(c) 2010-2016 Zoltan Herczeg
All rights reserved.

Copyright(c) 2009-2016 Zoltan Herczeg
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the names of any
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contributors may be used to endorse or promote products derived from this

software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes OpenShadingLanguage.
BSD 3-Clause License

Copyright (c) 2009-2019 Sony Pictures Imageworks Inc., et al.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes leptonica.
- Copyright (C) 2001-2016 Leptonica. All rights reserved.

- Redistribution and use in source and binary forms, with or without
- modification, are permitted provided that the following conditions
- are met:

- 1. Redistributions of source code must retain the above copyright
= notice, this list of conditions and the following disclaimer.

- 2. Redistributions in binary form must reproduce the above

= copyright notice, this list of conditions and the following

- disclaimer in the documentation and/or other materials

- provided with the distribution.

- THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS

- "°AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

- LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
- A PARTICULAR PURPOSE ARE DISCLAIMED. 1IN NO EVENT SHALL ANY

- CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
- EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,

- PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR

- PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY

- OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
- NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS

- SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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This product includes FCollada.
Copyright 2006 Feeling Software. All rights reserved.

Copyright 2005-2006 Feeling Software and
Copyright 2005-2006 Autodesk Media Entertainment.

Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN

THE SOFTWARE.

This product includes Botan.

Copyright (C) 1999-2022 The Botan Authors
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

This product includes tessdata.
Inc. Licensed under the Apache License, Version 2.0

This product includes XMP Toolkit.
Copyright (c) 2020, Adobe
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
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this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes ICU.

Copyright (c) 1995-2014 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice
appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

This product includes openexr.
Copyright Contributors to the OpenEXR Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.

* Neither the name of the copyright holder nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS

BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE

GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
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This product includes Bonjour SDK.
Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its
contributors may be used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes Qt.

The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C)

The Qt Company Ltd.

Portions of this software are copyright (C) 2006-2015 The FreeType Project
(www.freetype.org). All rights reserved.

Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
This software is based in part on the work of the Independent JPEG Group.

Secure Hash Algorithm SHA-3 - brg endian
Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

LICENSE TERMS

The redistribution and use of this software (with or without changes)
is allowed without the payment of fees or royalties provided that:

1. source code distributions include the above copyright notice, this
list of conditions and the following disclaimer;

2. binary distributions include the above copyright notice, this list
of conditions and the following disclaimer in their documentation;

3. the name of the copyright holder is not used to endorse products
built using this software without specific written permission.

DISCLAIMER
This software is provided 'as is' with no explicit or implied warranties

in respect of its properties, including, but not limited to, correctness
and/or fitness for purpose.
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2. Introduction to Data Exchange

The Esko Data Exchange plug-in for Adobe lllustrator combines several plug-ins into one package for

easier installation. The combined plug-ins are:

2.1. Data Exchange Preferences

The PDF Export Plug-In on page 30

The Ink Manager Plug-in on page 42

The Structural Design Plug-in on page 61
The Page Box Plug-in on page 81

The Inspection Setup Plug-In on page 87
Messages on page 90

E'sko Document Setup on page 93

Annotations on page 95

The option Update XMP on Document Savedefines if the document’s XMP data is updated when the
document is saved in the .Al format or as Adobe PDF with preserved lllustrator editing capabilities.

The option can be found in lllustrator > Preferences > Esko and is turned on by default. Deselecting

this option results in slightly faster document saves.
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3. The PDF Export Plug-In

3.1. Introduction

The PDF Export plug-in allows you to directly export your lllustrator files to Normalized PDF or to PDF+,
depending on the setting in the Ink Manager: see Normalized PDF or PDF+ on page 42

3.2. Saving a File as Normalized PDF or PDF+

To save your lllustrator file as Normalized PDF or PDF+ using PDF Export:

1. GotoFile>Export... > Export As...

2. Inthe dialog that opens, choose your file's name and location, and choose the Esko PDF (pdf)
format.

3. Click Export.

4. Inthe PDF Export Settings dialog that opens, fill in the export settings (see PDF Export Settings on
page 30).
5. Click OK to export the file.

3.3. PDF Export Settings

When exporting your files to Normalized PDF or PDF+ format, you need to set the PDF Export Settings.
The settings are different when exporting Normalized PDF (left) or PDF+(right), and depend on the
setting in the Ink Manager. See Normalized PDF or PDF+ on page 42

3.3.1. Preset

Using Presets you can store and reuse the settings for the PDF Export dialog.

You can save the current settings as a Preset by selecting Save... and entering a name. The location for
the Presets is defined in the PDF Export Preferences. See PDF Export Preferences on page 39

You can load a Preset by selecting it in the dropdown.

If you set the Preset to Default, the parameters as set in the PDF Export Preferences will be used. See
PDF Export Preferences on page 39.
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If the current settings are not saved as a setting, the Preset dropdown will show "Custom”.

3.3.2. PDF Export: Normalized PDF

Normalized PDF Export Settings
Preset: Default ~

Images And Linked Files: (O Embed Images
Save Links

[ Add Preview (max 72 DPI)
(O Copy Linked Files Next to Output File
© Use Links And Apply Server Mapping

] Copy Links If Not on File Servers

OFI And Server Mapping: Settings...

Trim Box: From Esko Trim Box =

Media Box: From Esko Media Box =

[ Outline All Text

[ Include Hidden Objects and Layers

Include Notes

[] Expand Patterns

[] Contourize Bitmaps

Convert Blended Objects to Images
Resolution: High (600 dpi) -

( Cancel )( 0K )

1. Set the Images and Linked Files settings. See Images and Linked Files on page 32
2. Set the Opi and Server Mapping settings. See OPI and Server Mapping on page 33
3. Set the Trim Box to be used:
« From Esko Trim Box: the Trim Box size and position will be taken from the Trim Box & Media Box
plugin. When not specified in the plugin, the size of the Artboard will be used instead.
+ Current Artboard: the Trim Box will have the same size and position as the Artboard.

« Artwork Bounding Box: the Trim Box will be as big as the bounding box of all currently
selectable objects in the document.

E Note: If any of the options is not defined, it will disabled in the dropdown.

4. Set the Media Box to be used:

« From Esko Media Box: the Media Box size and position will be taken from the Trim Box & Media
Box plugin. When not specified in the plugin, the size of the Trim Box will be used instead.

+ Current Artboard: the Media Box will have the same size and position as the Artboard.
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« Artwork Bounding Box: the Media Box will be as big as the bounding box of all currently
selectable objects in the document.

«  From Document Bleed: Bleed settings defined in Adobe lllustrator will be used as Media Box.

« Custom Margins: the Media Box will have the size of the Trim Box, Extended by the distance you
enter.

Note: If any of the options is not defined, it will disabled in the dropdown.

5. Enable Outline All Text to convert all text to outlines.
6. Enable Include Hidden Objects and Layers to include hidden objects when the PDF file is exported.

7. Enable Include Notes to include annotations in the PDF. This option is only available in combination
with the PDF Import plug-in.

8. Enable Expand Patterns to replace patterns by actual objects. The path containing the pattern fill,
will then be filled with the objects as defined in the pattern.

9. Enable Contourize Bitmaps to convert 1-bit images (linked or embedded) into vectors.

10. Convert Blended Objects to Images will convert blended objects to images. You can set the
resolution for this images to High (600dpi), Medium (300dpi) or Low (150dpi)

Note: In case of converting blended objects with different overprint setting (one is
overprinting, the other is not), the convertion might change the final result. The following
message is shown: "Rasterized Blend combines art in overprint and not in overprint mode.
Rasterization may have caused changed appearance."

Images and Linked Files

1. Inthe Images and Linked Files group, choose to either Embed Images in the Normalized PDF, or
Save Links to the images.

« If you choose to embed the images, you don't have any more preferences to fill in and you can
just click OK.

Note: This doesn't save the images’link information (except for linked ArtiosCAD
graphics, see Linked ArtiosCAD Graphics for Normalized PDF export on page 41).

» If you choose to use linked images, fill in the other preferences of the dialog.
2. Enable Add Preview (max 72 DPI) if you want your Normalized PDF to have a low resolution preview
of the linked images.
This preview allows you to view the linked images when opening your file for example in Acrobat.
3. Choose where to copy the linked images:
« Choose Copy Images Next To Output File to copy them next to the folder in which you will save
the Normalized PDF (so other applications like ArtPro or PackEdge can still open them when the
links are broken).

« Choose Use Links And Apply Server Mapping to keep the images where they are but update the
links (for example if the images are in a shared folder located on a different machine).

4. When choosing Use Links And Apply Server Mapping, fill in a Server Mapping if the share names on
the client machine and on the other server do not match.

a) When checked, Copy Links If Not On File Servers verifies if linked images are already on file
servers and if they are not, copies them along with the exported Normalized PDF file. Choosing
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this option also enables the File Servers... button where you add the machines that store linked
images so that Esko workflow servers can find them.

For more information, see OPl and Server Mapping on page 33

OPIl and Server Mapping

When you click the OPl and Server Mapping Settings button, either in the PDF Export Settings or in
the PDF Export Preferences, the OPl and Server Mapping dialog appears:

&)

OP! And Server Mapping

Server Name Local Share Server Share

Servers:

OPI Mapping:

Preview Mapping m

Note:

This dialog is available only when you have chosen to Save Links in exported Normalized PDF
files. When you export a Normalized PDF, OPI Mapping is applied first and then Server Mapping.

Servers

The top pane of the dialog configures Server Mappings. You need to use Server Mappings when the
Normalized PDF you output:

» haslinked images that are located on a different machine (file server),
- will be used on another machine (not your local machine or the file server).

Server Mappings allow you to map the image links from one share name to another automatically
on output. This ensures that the links are not broken when the Normalized PDF is used on another

machine.

For example:

« thelinked images are saved on a file server called “Server”, in a shared folder called “Images”,
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« your copy of lllustrator with PDF Export is on a Mac, and the shared folder containing the images
ismounted as “Hi-Res Images”.

« the Normalized PDF you export will be used on a PC, where the shared folder containing the
images is mounted as “Shared Images”.

Server

_

Images

MAG . PC

J

Shared_Images

Hi-Res_Images

Thelink to animage called "My Image.psd’is”Server/Hi-Res Images/My Image.psd’on
the Mac, and should be “\\Server\Shared Images\My Image.psd’onthePC.

When adding the Server Mapping in the OPI And Server Mapping dialog, you should enter the Share
Details as follows by:

« name of the file server in Server Name,
» name of the shared folder containing the images as seen from your local Mac in Local Share,

« name of the shared folder containing the images as seen from the other PC in Server Share.

Share Details

Server Name: | Server -

Local Share: Hi-Res Images -

Server Share: Shared_lmages

( Cancel )( 0K )
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Note:

« You can use subfolders in a Server Mapping.

Share Details

Server Name: | Serverl ~

Local Share: Hi-Res Images -
Server Share: Images/Hi-Res

( Cancel )( OK )

« Youcan also use Server Mappings to replace images (for example to swap low-resolution
for high-resolution images when the low-resolution and high-resolution images have
identical separations).

Share Details
Server Name: | Server v
Local Share: LowRes v

Server Share: HiRes

( Cancel )( oK )

To add the Server Mapping, do the following:

1. Inthe OPI And Server Mapping dialog, click the plus sign button to the lower left of the Servers
pane. This opens the Share Details dialog.

2. Enter or choose the name of the file server containing your linked images in Server Name.

3. Enter or choose the name of the file server’s share containing your linked images as it appears on
your local machine in Local Share.

4. Enter the name of the file server’s share containing your linked images as it appears on the other
machine that will use your Normalized PDF in Server Share.

OPI And Server Mapping

Server Name Local Share Server Share
Server Hi-Res_Images Shared_Images

Servers:

5. If you want to add another Server Mapping (to use your Normalized PDF on yet another machine),
repeat steps 1to 4.

To edit a Server Mapping, double-click it. To remove a Server Mapping, select it and click the minus
button to the lower left of the Servers pane.
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OPI Mapping

The lower half of the OPI And Server Mapping dialog configures OPI Mapping, which defines the rules
for image substitution when exporting a Normalized PDF in a more specific way than Server Mapping.
OPI stands for Open Press Interface.

To add an OPI mapping, do the following:
1. Click the plus sign to the lower left of the list pane. This opens the OPI Rule Editor dialog.

OP| Rule Editor

If All ~ of the following conditions are met: +

Full Path Is ~ [Jobfiles/Originals/images

Apply the following changes: +

Replace Full Path ~ [Jobfiles/Fixed/Images

2. After the word If, decide how many conditions that must be true for this mapping rule to take
effect: All, Any, or None.

3. Forthe condition In the top pane of the dialog, choose the element of the image file’s path to
examine in the first field. Image paths are in URI (Uniform Resource Identifier) format, such as
file://mymac/MacHD/images/lowres/tests/Spacebar_ CMYK.eps. As you select elements, further
controls appear on the same line to refine the condition. For example, if you choose Full Path Is, you
can click ... to browse for a folder, or click x to revert to the previous folder. To add a condition, click
+; to remove a condition, click -.

4. Once you have defined the conditions, define the changes to the path in the lower pane of the
window. Use the same process to define the changes as you did to define the conditions: choose
the change, then set its options on the same line. To add a change, click +; to remove a change, click

5. Click OK to finish defining the rule.

6. Toadd anotherrule, click +; to remove a rule, click -.

Consider again this example URI file name: file://ImageServer/[LOWRES/images/lowres/tests/
Spacebar_CMYK.eps.

« The condition Extension, Is Equal To, EPS will match.

« Folder Name, Starts With, lowres/ will match. You can specify the text ending with / to state that
it must be the entire Folder name and to make sure that directories starting with (for example)
lowres plus/ willnot match.

« Server Name, Is Equal To, imageserver will also match as the case is not compared.
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When you use more than one condition in a rule, the Replace 1st Matching Part Of Path and Replace
2nd Part Of Matching Path changes become effective.

Consider thisfile: file://Serv/SharedImg/LORESIMAGES/ANIMALS/LOWRES/myimage.eps

« with conditions of Folder Name, Contains, LORESIMAGES, and Folder Name, Contains, LOWRES.
- and changes of Replace 1st Matching Part Of Path, HIGHRESTIMAGES, and Replace 2nd Part Of
Matching Path, HIGHRES.

The first change will replace LOWRESIMAGES with HIGHRESIMAGES (since it was first), and the
second change will replace LOWRES with HIGHRES.

Notes and Restrictions

To copy the OPI settings between computers so they all are the same, copy AE10-
OPISettings.prefs.InWindows, that file canbe at C:\Documents and Settings\username
\AppData\Roaming\Adobe\Adobe Illustrator CSx Settings, butitsexactlocation
depends on the type of login (local or domain) and lllustrator version (CSx where x is a number). On the
Mac, this file is normally in Users/username/Library/Preferences/Adobe illustrator
CSx Settings/. Copy the file to the same location on the target machines.

There are a few restrictions when using OPI Mapping:

» The high-resolution images must be accessible from the client workstation.

« Ink Manager will not show extra inks that are present in the high-resolution images.

« When exporting the file using Shuttle, only the inks from Ink Manager are shown, not any extra ones
present in the high-resolution images.

» PDF Export, PowerTrapper Client and PowerTrapper Standalone will use the high-resolution images
and will know about any extra inks.

3.3.3. PDF Export: PDF+

PDF+ Export Settings
Preset: Default >

Trim Box: From Esko Trim Box A

Media Box: From Esko Media Box hd

[ outline All Text
[ Include Hidden Objects and Layers
M Include Notes

0O Copy Structural Design Files to
Server

( Cancel )( 0K )

1. Set the Trim Box to be used:

- From Esko Trim Box: the Trim Box size and position will be taken from the Trim Box & Media Box
plugin. When not specified in the plugin, the size of the Artboard will be used instead.

+ Current Artboard: the Trim Box will have the same size and position as the Artboard.
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« Artwork Bounding Box: the Trim Box will be as big as the bounding box of all currently
selectable objects in the document.

= ] Note: If any of the options is not defined, it will disabled in the dropdown.

\

2. Set the Media Box to be used:

« From Esko Media Box: the Media Box size and position will be taken from the Trim Box & Media
Box plugin. When not specified in the plugin, the size of the Trim Box will be used instead.

« Current Artboard: the Media Box will have the same size and position as the Artboard.

« Artwork Bounding Box: the Media Box will be as big as the bounding box of all currently
selectable objects in the document.

« From Document Bleed: Bleed settings defined in Adobe lllustrator will be used as Media Box.

« Custom Margins: the Media Box will have the size of the Trim Box, Extended by the distance you
enter.

= ] Note: If any of the options is not defined, it will disabled in the dropdown.

\

3. Enable Outline All Text to convert all text to outlines.
4. Enable Include Hidden Objects and Layers to include hidden objects when the PDF file is exported.

5. Enable Include Notes to include annotations in the PDF. This option is only available in combination
with the PDF Import plug-in.

6. If the Copy Structural Design files to Server option is enabled, when you export your PDF+to an
Automation Engine server, the Structural Design files used in your document will be exported next
to your PDF+ file.

Export multipage PDF

When in PDF+ mode, if your Adobe lllustrator contains multiple artboards, you will have the option to
export the document as a multipage PDF document.

PDF+ Export Settings
Preset: Custom hd

[ Use Artboards
© Al O Range:
Trim Box: Current Artboard =

Media Box: Current Artboard =

[ Outline All Text
[ Include Hidden Objects and Layers

® Include Notes

0O Copy Structural Design Files to
Server

( Cancel )( OK )

1. Enable Use Artboards
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2. Select All to export all Artboards as different pages, or enter a Range
3. Set the Trim box and Media Box

Only the option Current Artboard is available for the Trim Box. For Media Box, you can choose
Current Artboard, From Document bleed or Custom Margins

The exported PDF will have one page for every selected Artboard

« Objects whose bounding box overlaps or touches the defined Media Box will be included in the page.
« If one object of agroup is on the page, the complete group will be taken along.

« If an object or group overlaps or touches multiple Artboards, it will be duplicated on every page.

« Every page will have all the inks and the complete layer structure of the document

« The page order will be taken from the Artboard order in Adobe lllustrator

3.4. PDF Export Preferences

You can open the PDF Export Preferences by choosing lllustrator > Preferences > Esko > PDF Export
Preferences
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PDF Export Preferences PDF Export Preferences
General Mormalized PDF PDF+ General Normalized PDF PDF+
Trim Box: From Esko Trim Box - Images And Linked Files: () Embed Images

Media Box: From Esko Media Box v el

[J Add Preview (max 72 DPI)

] Outline All Text (O Copy Linked Files Next to Output File

[ Include Hidden Objects and Layers
Include Notes ] Copy Links If Not on File Servers

© Use Links And Apply Server Mapping

PDF Export Preset Settings Folder:
© Use Default Preference Folder

O Use Custom Folder OPI And Server Mapping: | Settings...

[] Expand Patterns

[] contourize Bitmaps

Convert Blended Objects to Images
Resolution: High (600 dpi) -

( Cancel )( 0K ) ( Cancel )( 0K )

PDF Export Preferences

General Normalized PDF PDF+
[] Use Artboards

[ Copy Structural Design Files to Server

( Cancel )( OK )

The main part of the Preferences contain the same settings as the PDF Export Settings: the General
tab contains settings used for Normalized PDF and PDF+, the Normalized PDF tab contains settings
only used when exporting Normalized PDF, and the PDF+ tab contains settings only used when
exporting PDF+.

The settings in the Preferences will be used if the "Default” preset is selected. See PDF Export Settings
on page 30

The PDF Export Preset Settings Folder defines the location where the Presets are saved: either the
Default Preference Folder, or a custom folder you can select by clicking the Browse... button. See also
Preset on page 30
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3.5. Linked ArtiosCAD Graphics for Normalized PDF export

When you export a document with linked ArtiosCAD graphics to Normalized PDF, the graphics are
treated slightly differently:

When choosing “Embed Images” in the Preferences:

« The ArtiosCAD graphics are embedded in your Normalized PDF.

» The original link information is saved in your Normalized PDF.

When choosing “Save Links” in the Preferences:

« The ArtiosCAD graphics are embedded in your Normalized PDF.

+ They are also copied to the location you define: Next To Output File or on another server (according
to a Server Mapping if defined).

« Thelink to the copied graphics is saved in your Normalized PDF.
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4. The Ink Manager Plug-in

The Ink Manager palette is a powerful pre-press color editing and proofing tool. You can easily identify
where Pantone colors are used within a document or where custom spot colors can be found, then
convert these colors to a custom spot color or to process colors.

The Ink Manager palette also allows you to specify crucial ink parameters such as the ink type, angle
and lineature. Once defined, these parameters are saved inside the lllustrator document.

4.1. Normalized PDF or PDF+

In the Ink Manager, you can switch between working in Normalized PDF or PDF+ mode. This mode
determines what type of PDF file you want to export your document to.

If you open a document that contains Technical Inks or Varnish Inks, the mode will be set to Normalized
PDF.

If you open a document that contains Processing Steps, the mode will be set to PDF+

If you open any other document or create a new one, the mode will be set according to the default
setting in the Ink Manager Preferences. See Ink Manager Preferences on page 48 The mode is saved
in the Adobe lllustrator file, so that the next time you reopen the document, it will be opened in the
same mode.

You can switch freely between Normalized PDF and PDF+ mode. However, if you switch, specific
functionality might get lost. If you for example switch from PDF+ to Normalized PDF, all Processing
Step information will get lost, and switching back to PDF+ will not bring it back.

What is the difference between PDF+, and Normalized PDF

Both PDF+and Normalized PDF are to a large extent regular PDF files that you can open and edit

in any other PDF editor or reader. However, PDF+and Normalized PDF files also contain additional
information, available to any Normalized PDF or PDF+ compatible editor. When choosing Normalized
PDF or PDF+ mode in the Ink Manager, the specific limitations and specifications of the chosen PDF
format need to be considered.

What PDF+ Normalized PDF
Ink order stored in file J J
Non-printing data(Cut, Die, ...) |Processing Step Layers Technical Inks & Varnish
and special processing steps
(varnish, ...)
Ink Types Normal, Opaque Normal, Opaque, Technical,
Varnish
Document Profile as output Obligated. If none is present, the
intent default profile will automatically
be added when saving.
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What

PDF+

Normalized PDF

Screening

Optional Screen Sets based
screening

Every object has screening.
Optional object based screening

Group and Barcode metadata

S

S

Marks PDF+ Marks can be applied in X
ArtPro+
ArtPro+ does not support
SmartMarks
Images Images can be Images can be
+ Embedded + Embedded
+ Linked & Embedded. If a PDF | Linked
+ file contains image links,
a full resolution embedded
version of the image will still
be saved in the file.
Placed Art (PDF)

X

Structural Design

\/ Limited to one Structural
Design file, and always using the
default Profile

4.2. Using the Ink Manager palette

To use the Ink Manager palette, choose Window > Esko > Ink Manager. The Ink Manager palette

appears.

Ed

Ink Manager

Ink Mame

1 . Process Cyan

2 . Process Magenta
3[] Frocess vellow

a [ process Black

s ] Pantone 2188 c
o [ PanTonE z3ssc

Base Inks: @ Normallzed PDF Mode

Ink Book
process

Type

Normal
Normal process
Normal process
Normal process
Normal PANTONE+ Solld C...
Normal PANTONE+ Solld C...

Printing Method
unknown

unknown
Unknown
unknown
unknown

unknown

< O -K +E

The Ink Manager lists all inks used in the document. For every ink you see a color patch, its name, and
additional information about the ink. You can define what columns you want to see in the Ink Manager
fly-out menu. See The Ink Manager fly-out menu on page 45

You can double-click an Ink to open the Ink Options. See Ink Options on page 45

Mode
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In the bottom left corner, you can see if you are working in PDF+ mode or Normalized PDF mode. See
Normalized PDF or PDF+ on page 42

Properties from Job Setup Status Icon

When connected to an Automation Engine, Ink Properties can be retrieved from the Job Setup. This
icon indicates the status of the connection. See Job Setup on page 48

=~ Refresh

To update the list of inks used within your document, click the Refresh button. After modifying a
document, click the refresh button to update the list of used inks.

8 Show Processing Steps Palette

Only available when working in PDF+ mode. This opens the Processing Steps palette. See Processing
Steps on page 53

*B' Move to Processing Step

Only available when working in PDF+ mode. This moves the objects using a specific ink into a
Processing Step. See Processing Steps on page 53

I select

To identify objects containing specific inks within your document, select the ink you wish to search for
and click the Select button. It is possible to select more than one ink at a time.

*E convert to CMYK

To convert a selected Spot Color from your document Ink list to a Process Color Mix, CMYK, click
Convert to CMYK. More than one ink can be selected at a time.

Note: Convert to CMYK is only available if you have a license for boostX, Channel Mapping,
DeskPack Essentials or DeskPack Advanced.

*[Z] convert to Other

To convert a selected ink from your document Ink list to another ink, click '‘Convert to other'. More than
one ink can be selected at a time.

Note: Convert to Otheris only available if you have a license for boostX, Channel Mapping,
DeskPack Essentials or DeskPack Essentials.

Note: Converting an ink will affect only line art. However, if you have DeskPack Advanced or
the Channel Mapping plug-in installed and licensed, converting an ink will also result in the
corresponding channel mapping for all images. See the Channel Mapping documentation for
more information.

Delete Ink Variant

When working in Normalized PDF mode, you can use Screening for Adobe Illustrator to create
exceptions to the screening settings for an ink. These exceptions appear in the Ink Manager list as
"Variants". To delete such an Ink Variant, select the ink variant which needs to be removed and click
the 'Delete Ink Variant' button. The objects will get the ink settings of the parent ink. See Screening in
Normalized PDF mode on page 50
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4.2.1. Ink Options

Double-click an Ink from the list to open the Ink Options dialog.

If you have multiple inks selected, you can change the properties of all the inks at the same time. The
dialog will show "#" for settings that have different values.

If you are working in PDF+ mode and have one single ink selected, you can set the Printing Unit. See
Working with Printing Units on page 57

The Ink Book dropdown contains all Ink Books that have the current ink defined. By default the last
used ink book is shown.

When working in PDF+ mode, the available Ink Types are Normal and Opaque. When working in
Normalized PDF mode, also Varnish and Technical are available.

« Theinktype for process inks cannot be changed. The ink type is always normal.

« The following Pantone inks are always opaque inks: Pantone 8003 C, Pantone 8021C, Pantone 8062
C, Pantone 8100 C, Pantone 8201 C, Pantone 8281 C, Pantone 8321C, Pantone 871C, Pantone 872 C,
Pantone 873 C, Pantone 874 C, Pantone 875 C, Pantone 876 C, Pantone 877 C. The ink type of these
inks cannot be changed.

| . Note: If you change an Ink to Technical or Opaque, the ink will be moved to the bottom of the
" Ink list. If you change the ink order afterwards, this new order will be respected.

When working in Normalized PDF mode, you can set the screening (Ruling, Angle, Dot Shape, DGC
Curve)for the ink. See Screening in Normalized PDF mode on page 50

For every ink, you can set the Printing Method.

If you are connected to an Automation Engine server, the dropdown will show the server Printing
Methods. If you are not connected to an Automation Engine server, you will see the default Printing
Methods and the local printing methods, saved locally in the Adobe Illustrator Preferences.

You can select a Printing Method in the dropdown, or you can type in a name to create a new Printing
Method. If Save printing method to presets is enabled, the newly created Printing Method will be
stored as a new preset, either on Automation Engine or in the local Printing Methods.

{ ' Note: All these Ink options are stored in the lllustrator document and are used by other

' DeskPack plug-ins like PowerTrapper Client, PowerLayout Client, etc. For example,
PowerTrapper Client will ignore varnish and technical inks and will take the opaqueness of inks
in account when determining trap directions.

4.2.2. The Ink Manager fly-out menu

45



ESKO

Esko Data Exchange for Adobe lllustrator

b4 %

Ink Manager Ink Options...
Ink Name Type Ink Book Printing Method

. Process Cyan Mormal Process unknown v PDF+ (Processing Steps Support)

. Process Magenta Mormal process Unknown Mormalized PDF Compatibility

|:| Process Yellow Normal process unknown )

. Process Black MNormal process Unknown Show PrOCESSIr]g Steps

Il PanTONE Dark Blua C Opague PANTONE+ Solld Coated Unknown Move to Processing Step k4

|:| PANTONE 123 C Normal PANTONE+ Solid Coated unknown Convert Ink to...

Convert Ink to CMYK

S SRCeE g o el Convert all Spot Inks to CMYK

Update Ink List
Process Inks in Images...

Display Columns >

Assign Default Printing Units
Assign Default Reverse Printing Units

Reverse Ink Order

Save CMYK Ink Order as Default
Restore Default CMYK Order
Sort Light To Dark

Sort Dark To Light

Save Inks Preset...
Load Inks Preset...

- Ink Options... opens the ink options dialog.

« Using PDF+(Processing Steps Support) or Normalized PDF Compatibility you can switch the mode
for the current document. See Normalized PDF or PDF+ on page 42

« Show Processing Steps and Move to Processing Step: Only when working in PDF+ mode. See
Processing Steps on page 53

Convert Ink to... has the same functionality as the '‘Convert to Other' button +[@

Convert Ink to CMYK has the same functionality as the 'Convert to CMYK' button +K
« Convert all Spot Inks to CMYK converts all the spot inks in the document to their CMYK equivalent.

{ = ] Note:

Keep in mind that this function will also convert white objects created by the White
Underprint plugin, using a special spot ink.

« Update Ink list refreshes the ink list.

« ProcessInksInimages... The plug-in uses lllustrator to determine which inks are used in images.
[llustrator has some limitations:

« Withlinked EPS images it is not possible to detect whether CMYK was used in the linked image.
Ink Manager will assume that CMYK is present in the linked EPS images, unless the user has
specified otherwise.

- TIFF images with spot channels always have CMYK channels, even if those channels are empty.

« Some effects create embedded images with all four CMYK channels, even if some are empty.
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So the plug-in doesn't really know whether CMYK is used in images. “Process Inks in Images” offers a
manual solution. If you click this option, the “Process Inks in Images” dialog box appears:

Process Inks in Images

B [] Process Cyan

B [ Process Magenta
[ ] [+ Process Yellow
B [/ Process Black

Cancel 0K

By default all toggles are switched on, which means that the plug-in will assume that external
images contain Cyan, Magenta, Yellow and Black.

If you know that there is no Cyan in the externally placed images or you want to avoid an empty
process plate introduced only by an effect, you can switch Process Cyan off. Click 'Apply' and at the
bottom of the Ink Manager the indication “Disabled in Images: C” will appear.

The plug-in will assume that only Magenta, Yellow and Black were used in the externally placed
images. If Cyan is used in other objects of the document, it will be listed in ink manager.

Note: Other plugins such as PDF Export and PowerTrapper will also take this setting into
¥ account.

Using Display Columns you can set what columns of the Ink Manager should be shown:

« thelnk Type

« thelnk Book

« the Screening Details (ruling, Angle and dotshape). Only when working in Normalized PDF mode.
See Screening in Normalized PDF mode on page 50

- the DGC Curve. Only when working in Normalized PDF mode. See DGC Curve on page 51),

« The Printing Method

- The Job Setup (see Job Setup on page 48)

Reverse Ink Order will turn the order of the inks upside down.

By default, the process colors are in Cyan - Magenta - Yellow - Black order. If you change this order

and apply Save CMYK Ink Order as Default, the changed order will be used as default order. By

selecting Restore Default CMYK order, the original default order is restored.

By using Sort Light To Dark or Sort Dark To Light, you can rearrange the order of inks based on the

luminocity. Note that Opaque and Technical inks are placed at the bottom of the list, but also sorted

light to dark or dark to light.

When working in Normalized PDF mode, if you have to reuse the same Ink Parameters frequently,

you can use Save Ink Preset ... to save all ink parameters, including Ink Name, Type, Ink Book,

Ruling, Angle, Dotshape, DGC and Printing Method. You can Load Ink Preset... to overwrite all ink
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parameters in the current document with the parameters you saved earlier. You can set the location
for the saved Ink Presets in the Preferences. See Ink Manager Preferences on page 48

- By enabling Use Properties from Job Setup, the inks and ink parameters defined in the Job Setup
will be enforced. See Job Setup on page 48

4.2.3. Job Setup

When a document is opened from an Automation Engine Job, for example using File > Job Folder
> 0Open from Job Folder ..., you can force Ink Manager to use the ink parameters defined in the Job
Setup, overwriting the current Ink Parameters, by enabling Use Properties from Job Setup, either

from the fly-out menu or by clicking the button in the Ink Manager palette E

The Job column will appear automatically. You can change its visibility under Display Columns in the
fly-out menu.

The column will give a status icon for every ink:

) l:l :the ink is defined in the Job Setup. The parameters defined in the Job Setup will be used.

) D :the inkis not in the Job Setup but is used in the document

44 : the ink is defined in the Job Setup but not used in the document. The line will be greyed out,
and have no number.

If Use Properties from Job Setup is enabled, the Ink Options dialog for inks defined in the Job Setup
will show statusicons for every parameter:

) l:l : the parameter is taken from the Job Setup, so it can't be modified.

) D : the parameter is not defined in the Job Setup, so it can be set freely.

If the Job Setup defines multiple variants of the same ink, all variants are listed in the Ink Manager.

E b ] Note: Next to the settings for every ink, you can also choose to retrieve the Ink Order from the
Job Setup, by enabling the option in the Ink Manager Preferences. See Ink Manager Preferences
on page 48

4.3. Ink Manager Preferences

The Ink Manager Preferences can be opened from lllustrator > Preferences > Esko > Ink Manager
Preferences...(Mac) or Edit > Preferences > Esko > Ink Manager Preferences... (Windows).
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Ink Manager Preferences

Default Document Mode: Mormalized PDF Compatibility ~

Default Values

Ink Name Angle Ruling

Magenta 52,5° 120 Ipi
Yellow 7,5° 120 Ipi
Black 82,5° 120 Ipi
Spot 45° 120 Ipi

[ show Inks of Non-printable Layers
] Show Inks of Hidden Layers

Use ClassicColors Ink Book
Preferred Ink Book:

© designer v

Ink Manager Preset Settings Folder:
Use Default Preference Folder

() Use Custom Folder

Job Setup Support:
[[] Retrieve Ink Order

l( Cancel )( 0K )

With the Default Document Mode you can define if you want to use Normalized PDF mode or PDF+
mode when opening a document created by Esko plug-ins older than version 20, created without Esko
plugins or importing as Adobe PDF. See Normalized PDF or PDF+ on page 42

In the rest of the Ink Manager Preferences, you can set the Default Values (angle and ruling) for CMYK
inks.

You can also set the default angle and ruling to be used for new Spot inks. However, these defaults can
be overruled when using a Spot ink that was used before, with a different Angle and Ruling value. The
Angle and Ruling for all used spot inks are saved in the Preferences file.

You can also define if inks that are only used in non-printable layers or hidden layers should be shown
in the Ink Manager by setting the Show Inks of Non-printable Layers and Show Inks of Hidden Layers
option.

{7] Note:

The Remap Ink functionallity also takes the Show Inks of Non-printable Layers and Show Inks
of Hidden Layers option into account: When switched off, inks on non-printable or hidden
layers will not be remapped.

Enable Use ClassicColors Ink Book to use the ClassicColors Ink Book. When using a ClassicColors Ink
Book for your HP device, you can enable the Use ClassicColors Ink Book option, to avoid conflicts for
inks using generic names, such as "White".
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The Preferred Ink Book is the Ink book shown by default when opening the Add Ink from Ink Book

dialog. It is also used as the preferred ink book when determining the ink book of spot inks manually
added to the document.

You can set the location to store Ink Manager Preset Settings: either in the default presets folder, orin
a custom folder you choose.

In Job Setup Support you can define if you want to use the Ink Order as defined in the Job Setup. See
Job Setup on page 48

4.4, Screeningin Normalized PDF mode

When working in Normalized PDF mode, you can set the screening parameters in the Ink Options.

(f ’ Note: The other options are explained in Ink Options on page 45

Ink Options

Ink Name: PANTONE 123 C
Ink Group: Spot Ink

Ink Book: o PANTONE+ Solid Coated b

Ink Type: Normal ~
Ruling: Ipi
Angle: 45°
Dot Shape: Mone hd

DGC Curve: MNone >~

Printing Method: Unknown ae

[] Save printing method to presets

( Cancel )( 0K )

You can set the Ruling and Angle for the ink.

Dotshape shows a list of all dotshapes available for the FlexRip. However, it is possible to enter any dot
that is available on your rip instead of the proposed dotshapes. Only use a dotshape that is installed on
the rip that will be used to expose the document.

(f ’ Note: Entering a dotshape is not compatible with Nexus RIP.

You can define a DGC Curve and a DGC percentage. See DGC Curve on page 51

The screening settings are applied to all objects in your document.
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If you have a Screening for Adobe lllustrator license, you can use the Screening for Adobe lllustrator
plugin to make exceptions to these inks parameters for specific objects. See https://www.esko.com/
en/support/product?id=Screening %20for7%20Adobe % 20lllustrator

4.4.1. DGC Curve

You can set the Dot Gain Compensation (DGC) Curve for every ink.

By default, the DGC Curve column is hidden. By selecting Show DGC Curve in the fly-out menu you can
make it visible.

You can select one of the predefined Dot Gain Curves, or type in the name to use a custom DGC. When
selecting a PressSync curve, you can enter the percentage for the curve in the DGC % field.

{ . Note: DGC is not a part of the Job Setup. This means using Use Properties from Job Setup
" will not change the DGC, nor does changing the DGC influences the status of the job.

4.5. Screening in PDF+ mode

In PDF+ mode, screening is defined using Screen Sets in the Ink Manager. See Manage Screen Sets on
page 52

{ . Note: You need a Screening for Adobe lllustrator license to assign a Screen Set to an object.
' Without the license, you can view the defined Screen Sets and you can change their screening
parameters, but you can't add new Screen Sets, delete Screen Sets or assign a Screen Sets to
objects. You can also Reset to Default Screening or Remove Screening without a license. See

The Screen Sets Fly-out menu on page 52

Your document can contain a number of Sereen Sets, each containing specific ruling, angle, dot shape
and DGC information for each of the defined separations. By assigning a Screen Set to an object, you
can set up object based screening.

Choose Window > Esko > Screen Sets or use its shortcut Cmd+Option+Shift+N (Mac) or Ctri+Alt
+Shift+N to open the Screen Sets palette.

= 44

Screen Sets =

None
Basic Screen Set

Scrasn Sat 2

ooogd

stragn Sat 1

The Screen Sets palette shows all Screen Sets defined in the document.

The Screen Sets used in the current selection will be highlighted.
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» Click the Screen Set you want to assign to the current selection.

* Click the Select Art Using Screen Set button I to select all objects using that specific Screen
Set.

* Click the Manage Screen Sets button ¥ or choose Manage Screen Sets from the fly-out menu
to create, remove or edit your Screen Sets. See Manage Screen Sets on page 52

Manage Screen Sets

In the Manage Screen Sets dialog you can add, remove and edit Screen Sets.

Screening
Basic Screen Set # Separation Ruling  Angle Dot Shape DGC %
1 PANTOME 123 C 120 Ipi 45° Elliptical (E)
Screen Set 1
2 Process Cyan 120 Ipi  22,5° Elliptical (E
Screen Set 2 e P P =
3 M Process Magenta 120 Ipi  52,5° Elliptical (E)
4 . Process Black 120 Ipi  82,5° Elliptical (E)
5 120 Ipi 7,8° Elliptical (E)
s 0 Ipi 0°
+
Load Preset... Save Preset... ( Cancel ) ( 0K

« Inthelist on the left, select a Screen Set to see and edit its settings.

« You can set the Ruling and Angle for each ink.

» Dotshape shows a list of all dotshapes available for the FlexRip. However, it is possible to enter
any dot that is available on your rip instead of the proposed dotshapes. Only use a dotshape that
isinstalled on the rip that will be used to expose the document.

+ You can define a DGC Curve and a DGC percentage. See DGC Curve on page 51
« Click +to create a new Screen Set.

The newly created Screen Set is created using the same settings as the currently selected Screen
Set. If no Screen Set is available, a Screen Set with default screening information is created.

« Click-toremove the selected Screen Set.
« Double-click a Screen Set to rename it.
« Clickinfront of a Screen Set Name to make it the Default Screen Set, indicated by a star.
The Default Screen Set is applied to newly created objects. It is also used in some other specific
situations, e.qg. if you remove a Screen Set, or for Mask objects when releasing an Opacity Mask.
« Click Save Preset to save all Screen Sets in a Screen Preset, e.g. to reuse in another document.

« Click Load Preset to load all Screen Sets saved in a Screen Preset. The Screen Sets from the Preset
will be merged with the current Screen Sets. If a Screen Set with the exact same settings already
exists, that Screen Set will not be added.

The Screen Sets Fly-out menu

The Fly-out menu of the Screen Sets palette contains the following functions:
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Reset to Default Screening

This removes all Screen Sets, and adds a new one called "Screen Set 1". The screening information for
this Screen Set is taken from the settings defined in the Ink Manager preferences. See Ink Manager
Preferences on page 48

Remove Screening

This removes all Screen Sets applied to objects in the current document. The Screen Sets palette will
only contain the "None" Screen Set.

{ ' Note: Both functions are available without the Screening plugin installed, and without a

| Q
license.

4.6. Processing Steps

Ever since PDF became the preferred file format in the graphic industry, PDF files were used not only
to store the artwork to be printed, but also as a container for information related to the production
process: cutting lines, dimensions, etc.

How the information was stored in the PDF file, depends on the application that was used to generate
the PDF, and the preferences of the user. For example the die cut lines can be in a separation called
"Die", orin a layer named "Cut". Obviously, this leads to a multiple of ad hoc methods, which leads to
interoperability problems, and a complex and error-prone situation.

ISO 19593 defines a new mechanism to store objects and metadata corresponding to such processing
steps in a PDF file in a standardized way.

Based on this ISO norm, the use of Processing Steps was introduced in DeskPack as Processing Steps.

Keep in mind however that these Processing Step Layers are only available when working in PDF+
mode. Normalized PDF mode uses Technical Inks instead. See Normalized PDF or PDF+ on page 42

Objects in Processing Step Layers

Processing Step Layers contain objects in your PDF file (a path, a text object, ...) that are associated
with a specific Processing Step.

The type of Processing Step Layer can influence the properties of the PDF objects. For example, a PDF
object in a Structural Processing Step Layer has to be colored in a spot color (to visualize in viewing
and proofing applications). Because the objects in these Processing Step Layers should not have any
influence on the final printed version (and on the plate making), this spot color should not be used for
"normal” PDF objects, nor should the objects knock out other objects, or participate in transparency
blending with other "normal” artwork objects.

Types of Processing Step Layers

« Structural Data: a collection of contours that describe how the printed product will be finished to
produce a 3D end product from a flat substrate, such as cutting lines, crease lines, etc.

« Braille: braille characters that are applied after printing, e.g. by a die cutter or inkjet device.

« Legend: job related data outside the boundaries of the actual printed products.

- Dimensions: indications of the physical sizes

« Positions: objects that indicate intended, allowed or forbidden positions for certain types of
elements, e.qg. allowed positions for content on a flap of a carton.

«  White: white ink to be printed on a transparent or metallic substrate.
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« Varnish: indicating the application of varnish after printing.

4.6.1. The Processing Steps palette

54

You can open the Processing Steps palette by clicking the Show Processing Steps button B o
select Show Processing Steps in the fly-out menu of the Ink Manager palette.

b3

Processing Steps

Lo

Lo

L0

Lo

L0

Foom select [_| Highlight

Structural
Cutting

whita

Esko_FlatelD

Artwork

A IS0 Standard Violations

Fllls are not allowed (2).

2
]
i
i

All the Processing Steps appear in the list, grouped per type, along with an "Artwork" entry. You can use
the eye icon to make a processing step visible or invisible.

You can change any layer into a Processing Step Layer, or change the type of a Processing Step Layer
by clicking the Edit Processing Steps button, by selecting Edit Processing Steps... in the fly-out menu,
or by double-clicking an entry in the list.
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Edit Processing Steps

Choose the appropriate processing step types for the layers in this document:

Cuts * None
Folds ¥ Folding

~ Layer 1 * None

Sublayer * None

( Cancel )l( OK

You can change any layer into a Processing Step Layer, or change the type of a Processing Step Layer
by selecting a Processing Step type from the dropdown.

You can change a Processing Step Layer into a normal layer by selecting None.

Unlike normal Artwork layers, Processing Step Layers come with a set of restrictions. If one of these
restrictions is not met, a warning is shown in the Processing Steps palette.

You can select the paths causing the warnings in the list. If the Select option is enabled, clicking on
one of the entries will select the corresponding object in the job. If the Zoom option is enabled, clicking
an entry displays the selected object as big as possible in the active window. If the Highlight option is
enabled, the selected objects will be highlighted.

Note: The list of ISO Standard Violations is not updated automatically. Use the refresh button
“=% toupdate the list.

You can prevent a number of these issues by using the Move to Processing Step function to create
Processing Step Layers. See Move to Processing Step on page 56

Colorants for Processings

Inks that are only used in Processing Steps are considered "Colorants": they can be used to color
objects in the Processing Step Layers, but are not considered printing inks, as they should not appear
on plates or on the final printed result.
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Colorants for Processing Step Layers are represented in the Ink Manager using a round color patch.

’ ' Note: If aninkis used in at least one "normal” artwork object in an artwork layer, the separation
is shown as a normal printing separation, with a square color patch. Since the use of a
separation both as ink and as colorant usually presents a conflict, it is very likely that a
message will appear in the Messages Side Drawer for any Processing Step Layer using such a
colorant.

4.6.3. Move to Processing Step

Using the Move to Processing Step function, you can move the objects using a specific ink into a

Processing Step.

1. Selectaspot colorinkinthe Ink Manager.

2. Select Move to Processing Step from the fly-out menu or click the Move to Processing Step button
+B

3. Select the Processing Step Layer you want to use.
4. All objects using the selected ink will be moved to the selected Processing Step Layer.

+ Objectsinaflat color, only using the selected separation, will be placed in a Processing Step
Layer, with the same name as the original artwork layer they were in (when available).

« Other objects(e.g. objects in a mixed color, images, ...) will not be moved nor changed.

« Ifthelnkisonly usedin the Processing Step Layers, it will become a Colorant. See Colorants for
Processings on page 55

4.6.4. Plate ID Objects

56

If you are using DeskPack and/or ArtPro+ in combination with Esko's Imaging Engine within the
flexographic printing industry, you can use Plate ID objects to identify Flexo Plates, e.qg. for reprint after
being archived, or to be reused in a similar jobs.

Plate ID objects will be exposed by the RIP at "half height". This means the objects are permanently
visible, yet they do not show up on the printed result.

For more information we refer to the chapter on Working with Plate ID in the Automation Engine
documentation here

1. Select the objects you want to create a Plate ID object of.

{ . Note: Foreign art, mesh, raster, linked image, repeat art and clipping paths are not
supported. Unsupported objects in the selection will be excluded.

2,
In the Processing Steps palette, click the Convert to Plate ID Object button B

» Ifthey don't exist yet, a Plate ID Layer and Plate ID ink are created.

« All(supported)objects in the selection are converted into one Plate ID Object. Marks in the
selection will be expanded and thus no longer be dynamic.


https://docs.esko.com/docs/en-us/automationengine/22.03/userguide/home.html#en-us/common/ae/concept/co_ae_WorkingWith_Plate_ID.html

ESKO

Esko Data Exchange for Adobe lllustrator

If the original object has no fill (‘'none'), the Plate ID Object will also have no fill. In all other cases,
the object is colored in 100% of the Plate ID Processing Step colorant. Gradients and patterns
are changed to 100% flat paint.

The Plate ID Object is set to overprint, and transparency settings are set to "Normal" at 100%
opacity.

The Plate ID Object is moved to the Plate ID layer.

3. Using the Plate ID palette you can define on what plates the Plate ID Object has to be exposed.

Plate ID

Apply on Plates for:

a)

b)

c)

[l Process Cyan
[ Process Magenta
[ ] Process Yellow
9 [ Process Black
O @ Plate ID

[l PANTONE 280 C
O ) white

O] @ die cut
( cancet ) ok )

Select the Plate ID object you want to edit, and click the Edit Plate ID Object Properties button
+ it

'In r

By default all artwork separations will be enabled, while Processing Step colorants and unused
separations are disabled. You can however manually add or remove separations.

Click OK

4.7. Working with Printing Units

Using Printing Units you can define a Printing Order without changing the viewing order in the Ink
Manager. For more information on Printing Order vs Viewing Order, see Viewing Order vs Printing Order
on page 58

(f ’ Note: Printing Units are only available in PDF+. See Normalized PDF or PDF+ on page 42

By default, the ink order (i.e. the viewing order)is also used as printing order.

You can switch to using Printing Units by choosing Assign Default Printing Units or Assign Default
Reverse Printing Units from the fly-out menu of the Ink Manager

The Printing Units icon =% or =1 is shown above the first column, and the arrow indicates the
printing direction.
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«  When choosing Assign Default Printing Units Printing Units will be assigned to all separations
except for Processing Step Separations in ascending order.

«  When choosing Assign Default Reverse Printing Units Printing Units will be assigned to all
separations except for Processing Step Separations in descending order.

After assigning the Printing Units, you can edit them by clicking the Printing Unit number's location,
or by opening the Ink Options. See Ink Options on page 45. You can use this e.g. to assign a Printing
Station to your Opaque White Processing Step Separation, or to leave an empty station.

. Note: When possible, Ink Manager will try to adjust the other Printing Units when changing
one. E.g. when in a sequential order you change "4" to "5", the next Printing Units will be
increased as well (5 becomes 6, 6 becomes 7 etc).

« When the Printing Units are no longer strictly ascending or descending after manually modifying the
Printing Units or changing the separation order, the icon in the Ink Manager changes to this: =o

« You can correct this by manually modify the Printing Units, or by re-assigning the default Printing
Units (see above).

If you want to remove Printing Units, you can choose Remove Printing Units from the fly-out menu of
the Ink Manager.

4.7.1. Viewing Order vs Printing Order

58

By default, the order of the separations in ArtPro+ defines both the viewing order and the printing
order(what ink is printed first). In the example underneath, you see an example of a clear substrate,
with an opaque white printed first, and CMYK on top.

x

Ink Manager
H S Ink Name Type
1 O White Opague
2 [J] Frocess cyan NMormal
3 [Jl] Frocess magenta Normal
a[] process vellow Normal
s [ Frocess Biack Normal
Inks: 5 PDF+ Mode

However, in some cases, you would want to change the printing order, without changing the viewing
order in ArtPro+. If you for example want to print on the inside of a clear substrate (so that the printed
graphics are protected by the substrate), the opaque white ink would be the last ink you print (and end
up on top of the others). You do not want to change the separation order in ArtPro+ to represent that,
as the opaque white ink would block out all graphics underneath.

To avoid this, you can use Printing Units to reverse the printing order without changing the separation
viewing order.
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< Imk Manager

H Ink Mame
5() wnite
a [l Process cyan
3[Jli] Process Magenta
F |:| Process Yellow
1 Frocess Black

e

Inks: 5 FDF+ Mode
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Type
‘Opaque
Normal
Normal
Normal

Normal

Underneath an example of a label printed on the back side of the clear substrate:

4.8. Known limitations

Re-mapping process inks to spot inks.

As itisimpossible to simply change one of the process inks to the spot ink, the only solution is adding a
new fill to the object with the new spot ink and use overprint to mix these fills together.

« Adding abrand new fill is not possible on text objects on the character level. Text objects using
various inks on separate characters aren't mapped and an operator is warned.

» Re-mapping of process to spot inks on paths, using Effects on fill or stroke, will raise a warning,
because adding a new fill could change the visual appearance.

Re-mapping inks in gradients

Re-mapping of the process ink to the spot ink generates a new fill due to the same reason as before.
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« Let's have an example that the gradient already contains the target spot ink on one of its stops and
another stop contains the process color being transformed. The re-mapping one of the process
inks will add a new fill with the same gradient but with the target spot inks on the place of the
process ink. In other cases the overprint will blend these two fills and produce expected visual
appearance. In this particular case Illustrator will not blend these fills because both contain the
same spot ink and lllustrator then ignores the overprint. An operator is informed about that.

« Similar issue comes when the object already contains two gradient fills. An operator is again
warned.
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5. The Structural Design Plug-in

5.1. Introduction

Introducing Structural Design

Structural Design enables the Adobe Illustrator users to read in an ArtiosCAD ARD or ACD file, an

Esko flexible .bag file and/or a Collada .dae or .zae file. This structural design can then be aligned to
the graphics and this alignment will be maintained in the rest of the Esko workflow (e.g. ArtiosCAD,
Visualizer, PackEdge, ArtPro, Plato, RIPs). On top of that, you can create a varnish plate from the bleed
outline, from the lllustrator artboard or from the bounding box of the structure automatically excluding
the coating free areas.

Structural Design Export allows an Adobe Illustrator user to export contours from Illustrator to native
ArtiosCAD .ard format. It also allows adding and modifying cutout windows to a loaded ArtiosCAD file.

Structural Design files in Normalized PDF or PDF+
When exporting your document to PDF+, a live link is maintained to each of the placed printable parts.

However, if you export to Normalized PDF, only the printable part that is listed first in the layers palette
will be kept live, other placed printable parts will be expanded. If you want to keep a live link to your
printable parts while exporting to Normalized PDF, you should break up your multi-part design in
different documents, so that each document contains one printable part, and the graphics for that
printable part.

For more information on Normalized PDF and PDF+, see Normalized PDF or PDF+ on page 42

{ = ] Note:

ArtiosCAD ACD files can't be handled by PackEdge, ArtPro, Plato and Esko RIPs, and can't be
preserved in PDF+ or Normalized PDF export.

You can export the ACD file to separate ARD files by choosing File > Structural Design > Export
and selecting the name of the ACD file. If you choose the option "ARD Files (One per part), each
placed printable part of the ACD file will be replaced by a newly created ARD file. See Structural
Design Export on page 70

5.2. Importing Structural Design files

5.2.1. General Principles

The Structural Design plug-in enables you to open or place Structural Design files inside Adobe
lllustrator. The imported Structural Design files are linked to the Adobe lllustrator(.ai) files, but they are
not embedded.
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Structural Design Files and Printable parts

A Structural Design file describes a 3D scene, of which at least one part can be printed: the Printable
Part. Different types of Structural Design files can be used:

« an ARD Structural Design file, created in ArtiosCAD or Studio Toolkit for Boxes, mainly used for
boxes. For an ARD file, the entire box is one single printable part.

« an ACD Canvas file, created in ArtiosCAD, contains one or more printable parts.

{ = ] Note: Copies of the 3D Shape in ArtiosCAD will share the same printable part. In order to
apply different graphics on multiple shapes coming from the same ARD file, you should
import this ARD file multiple times into the canvas file. That way, each shape will have its
own printable part.

« .bagfiles created in older versions of Studio Toolkit for Flexibles. These .bag files are also one
printable part.

« Collada files, containing one or more 3D shapes with at least one printable part (.dae or .zae files).
For Collada files, a printable part is an Esko extension. A collada file can contain one or more
printable parts, such as a flexible bag, one or more labels on a bottle, a shrink sleeve, .... A Collada
file can also contain non-printable parts, such as the glass bottle itself. Collada files with one or
more printable parts can be created in ArtiosCAD or Studio Toolkit.

i = Note: More technical information on Printable Parts in Collada files can be found in the white

paper you can find in the Studio documentation: https://www.esko.com/en/support/product?
id=Studio

With the Structural Design Import plug-in, you can place printable part(s) of a Structural Design file in
an lllustrator document.

Structural Design Layer

After opening or placing a structural design file, the file appears in the Adobe lllustrator layer palette.
The Structural Design paths are special paths that cannot be modified accidentally. By default the
Structural Design layer and its sublayers will be locked. You can unlock the Structural Design layers.
This enables you to select individual Structural Design paths and use the illustrator alignment tools to
align graphics to the Structural Design paths.

5.2.2. Open or Place an ARD, ACD, BAG, DAE, ZAE file

A dedicated Place File showing only Structural Design files is found in the File menu. Choose File >
Structural Design > Place File....

In case a Collada file is placed, a check is performed to see if the Collada file has a printable part
defined. See General Principles on page 61

If a Collada file or ACD file contains multiple printable parts, a dialog will ask you to choose one or to
place all. Choose the part(s) of which you want to create the graphics in Adobe lllustrator.
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Select Printable Part(s)

The Collada file has multiple printable parts. Place:

Back Label
+ Back Label
Front Label
_] Round Label
Top Label

e

All printable parts

=

After opening a Structural Design file, the Structural Design objects are converted to special lllustrator

objects.

The Structural Design layers are converted to locked lllustrator sublayers so they can't be changed
accidentally. You can unlock these layers. They are grouped under a layer that gets the name of the

Structural Design file.

x

Layers
® & I ~ E Expert_Design.ard o
o I ~ E Main Design 2]
e i > [] e s}
® I » I:‘ Crease =]
® I |:| Layer 1 (o]
2 Layers b |
%
Layers
©a|-~ 20520 F5U DISPLAY.ACD o
o » [:‘ Tray ]
© I > |:| Tab o]
PN I 3 |____| Side Support o]
FoY I > D Front Support 8]
© I » D Bottom Q
© > Base o]
FoN ~ D Back Support o]
® | v D Main Design o
© I » D Cut o
© I > E Layer 1 o]
2 Layers 4 LI I T

The different Structural Design line styles (cuts, creases, bleed) are translated to hard-coded custom

colors. All ArtiosCAD line styles are supported.

x

Layers

@ & I ~ |:| Spray bottle.dae

o ~ D print_areal

© a| v [] main Design
o I I:I Cut

@ I |:| Layer 1

2 Layers

x

Layers

© & I ~ QuattroSealBag.zae
o w print_areal
b4 I o Main Design

© I > D Cut
& b I:I Crease
(] » I:I Fold
@ I I:‘ Layer 1

2 Layers
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Bl O © O|OC OO

=
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Text & Dimensions Ge_ngn'c special ll.l_| e
Cut Nick

Crease Print registration

Second Height Crease Qutside bleed
Matrix Crease Inside bleed

Generic perforation

Partial Cut

Generic Cut and Crease
Printimages

Annotation

Reverse crease Annotation2
Reverse partial cut Annotation3
Annotation4

Half crease Annotations

e bevel Other lines...

Opening an lllustrator file with a placed Structural Design file
When an lllustrator file is opened that contains Structural Design data, two checks are performed.

1. First of all, the plug-in checks whether the Structural Design file still can be found in its original
place. If that is not the case, the plug-in will look for the Structural Design file in the same directory
where the lllustrator file is. If it finds the Structural Design file there, it will use this Structural
Design file instead, otherwise, you will be asked to browse to the new location of the file.

2. Asecond checkis performed to see if the Structural Design file has been modified since it was
originally embedded in this Illustrator file. If so, the lllustrator document will be updated.

See also Update the Structural Design File on page 65

Adding or replacing a Structural Design File

If a Structural Design file is already loaded and you place a new Structural Design file, the new
Structural Design file will be placed next to the already loaded Structural Design file.

If you want to replace an already placed Structural Design file, choose File > Structural Design >
Replace. See Replace the Structural Design File on page 65

Placing or opening

The difference between placing and opening a Structural Design file is that when opening a Structural
Design file, the artboard will adopt the size of the bounding box of the structure. When placing a
Structural Design file, the artboard will not be changed.

Large Canvas mode

In Adobe Illustrator versions before 24.2 (released june 2020), the maximum size of an Adobe Illustrator
document was 5,779 by 5,779 meter or 227,52 by 227,52 inch ("standard size").

In Adobe lllustrator 24.2 and later, when creating an Adobe lllustrator document, you can use larger
sizes. In that case, the document is in "Large Canvas Mode". The maximum size of an Adobe lllustrator
document in Large Canvas mode is 10 times larger: 57,79 by 57,79 meter or 2270 by 2270 inch.
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When opening a Structural Design file, the Adobe Illustrator document is created in regular mode. If
the printable part you place doesn't fit the "standard size" canvas, you can choose to create a document
in "Large Canvas Mode", and place the structural design file in the newly created large-sized Adobe
[llustrator document.

Warning: When you save or export the artwork created on a large-sized canvas to a legacy
lllustrator document (lower than lllustrator 2020), the artwork will appear ten times smaller.

In this case, the Structural Design Import plug-in will expand all structural design artwork.
This means that the artwork will no longer be tagged as Structural Design objects, and will
become reqgular lllustrator art. The structural design data will no longer be live in such a legacy
document.

Update the Structural Design File

If any of the Structural Design files has been modified while still editing the lllustrator file, an update
of the Structural Design files can be forced. All Structural Design files placed in the current Illustrator
document will be updated. Choose File > Structural Design > Update All

Replace the Structural Design File

If you want to replace the placed printable parts of a Structural Design file while preserving the
alignment between the technical drawing and the artwork, you can replace a Structural Design file.

Choose File > Structural Design > Replace and select the name of the file you want to replace

5.2.5. Align Structure and Graphics

Interactive Move Structural Design tool
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b 4

= Selection Tool (V)
¥ <R bX Select Tool
=)= bX Dust Tool
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k’j’ Move Structural Design
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The Move Structural Design tool has been added underneath the lllustrator select tool. Select this tool
to move the Structural Design interactively without unlocking the Structural Design layers. Hold down
the mouse button and drag to move the Structural Design.

2
(@) —
~
=]
=

N4

If you choose View > Smart Guides, the Structural Design will snap to the graphics.

Structural Design window
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x 11

Structural Design

Bottle.dae - Front Label b
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X: §Bs.O5Z2 mm

Y: EBO9.028 mm

Print Side: Front

Structure Bleed
1_._ W - 2B BY9E mm W Dmm
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Bleed Offset: O mm

i ]
[i]

The Structural Design palette provides information on the bleed and structure contours of the selected
printable part. It allows you to rotate or numerically move the contours.

Open the palette by choosing Window > Esko > Structural Design > Show Structural Design Window.

If your document contains multiple printable parts, you can use the dropdown to select the printable
part for which you want to see or change the information.

If your selected printable part contains a bleed contour, you can use the dropdown to choose whether
you want to see the position of the bleed or of the structure bounding box.

The upper part gives you the coordinates of the (left, top) point of the bounding box around the
structure (cut and crease) or bleed contours. The coordinates are relative to the origin of the lllustrator
file. You can choose to see the coordinates of nine points on the bounding box. You can also choose to
see the position of the bounding box around the bleed contour.

By entering a new value in the X and Y entry fields, you move the selected point to the new position.

It is possible to flip the Structural Design so that you can add graphics to the back of the Structural
Design. This feature is enabled for ArtiosCAD files and for Collada files with a placed printable part that
can have graphics applied to the back side.

The lower part of the palette shows the width and height of the Structure and Bleed bounding boxes.
Bleed Offset indicates the offset between the structure and the bleed contour.

The bottom part provides information whether or not fold angles and animation were defined in the
structural design.
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Click one of the Rotation icons to rotate the Structural Design contours. Rotation always happens
around the center of the structure contour.

5.2.6. Create Varnish Plate

Choose Window > Esko > Structural Design > Create Varnish Plate....

Create Varnish Plate

() Use Artboard

© Use Bounding Box of Structure

Offset Omm

( Cancel )( OK )

« If you choose Use Bleed Outline then the contour will be created from the bleed outline
minus the coating free areas (if any).

» If you choose Use Artboard, then the contour will be created from the Artboard minus the
coating free areas.

« If you choose Use Bounding Box of Structure, then the contour will be created from the
Bounding Box of the structure minus the coating free areas.

| . Note: When using Use Bleed Outline or Use Bounding Box of Structure, a varnish
plate will be created for every printable part in the current Illustrator document.

When choosing Use Artboard or Use Bounding Box of Structure, you can specify a positive
or negative offset. The resulting varnish plate will be enlarged or shrunk with the specified
offsetin relation to the artboard or the bounding box.

This tool outputs a contour filled with a light-yellow spot color. This contour will be put in
anew layer named ‘Varnish'. This layer will be inserted directly under the Structural Design
layers.

{ ' Note:
]
Create Varnish Plate will automatically exclude the coating free zones in the
Structural Design file, if any.
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5.2.7. Expand Structural Design Layer

Choose Window > Esko > Structural Design > Expand Structural Design Layer....

Expand Structural Design Layer

Expand Structural Design Layer:
Main Design w

Into a New Layer:

|Layer 3l |

Select the Structural Design layer that you want to expand into a new lllustrator layer. If there

are multiple printable parts with a Structural Design layer with the same name, they will all be
expanded.

All art on the Structural Design layer will be copied to the new lllustrator layer. The art on the
new layer is no longer tagged as Structural Design objects.

In Normalized PDF mode, the resulting objects are in the technical Structural Design inks. In
PDF+ mode they will share the same processing step types of the corresponding layers in the

Structural Design. See also Normalized PDF or PDF+ on page 42 and Processing Steps on page
53.
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One common use where you would use this tool is when you are interested in creating a
clipping path from the bleed outline of the Structural Design file.

Structural Design Preferences

You can open the Structural Design Preferences by choosing lllustrator > Preferences > Esko
> Structural Design Preferences... on MAC or File > Preferences > Esko > Structural Design
Preferences... on PC.

Structural Design Preferences

Dynamic Placeholders

[ Import Dynamic Art as Placeholders

( Cancel )( oK )

ArtiosCAD files can contain Dynamic Art placeholders. Using these placeholders, a structural designer
can for example tell the graphics designer where the barcode should be placed on the design. If

the option Import Dynamic Art as Placeholders is enabled, and you have the Dynamic Art plugin
installed, a live Dynamic Art placeholder object will be created for every ArtiosCAD Dynamic Art. These
placeholders can then be filled automatically with their content. For more information, we refer to

the Dynamic Content documentation. See https://www.esko.com/en/support/product?id=Dynamic
%20Content %20Advanced

5.3. Exporting Structural Design files

5.3.1. Structural Design Export

5.3.2.

70

The Structural Design Export saves a copy of the selected Structural Design file to a new location,
The lllustrator file will link to the newly saved Structural Design file. Choose File > Structural Design >
Export and select the Structural Design you want to export.

If you are exporting an Artios Canvas file (.acd) containing multiple printable parts, you can choose to
export the ACD file as a single ACD file, or as multiple individual ARD files, one for each part.

Export Selected Objects to ArtiosCAD File

ArtiosCAD Export adds the item Export Selected Objects to ArtiosCAD File to the Structural Design
menu. Only ARD files can be included when exporting to a new ArtiosCAD file.

Select the contours to export to the ARD file and choose File > Structural Design > Export Selected
Objects to ArtiosCAD File.

The Export Selected Objects to ArtiosCAD File dialog opens.
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Export Selected Objects to ArtiosCAD File

Preview
ArtiosCAD File

Save selected objects in:

(O Main Design Layer

(O Annotation layers based on Adobe lllustrator layers

© Layers based on ArtiosCad Line Type swatches

Include a copy of Expert_Design.ard

Graphics layers are not copled. Rebuilding the design will not
be possible.

Remove Lines...

[C] Place this ArtiosCAD file in the document

The current ArtiosCAD file will be replaced by this saved file.

[J Highlight Selection ( cancel ) (Export.. )

Save selected objects in

You can choose to save the selected objects in the Main Design Layer or in Annotation Layers. If you
save them in Annotation Layers, an ARD file will be created with annotation layers with the same name
as the illustrator layers.

Next to this, you can choose Layers based on ArtiosCAD Line Type swatches. If the selected objects
are stroked with a swatch color with an ArtiosCAD line type name (e.qg. cut, crease, bleed), then this
option will create layers depending on the stroke color name:

« Cutand crease lines will go to a Main Layer

« QOutside Bleed lines will go to an Outside Bleed Layer

« Qutside Coating lines will go to an Outside Coating Layer
« Dimensions and text will go to a Dimension Layer

« Allother linetypes will go to an Annotation Layer

For convenience, a swatch library ArtiosCAD Line Types is included with the plug-in. You can display
the swatch library by selecting Window > Swatch Libraries > ArtiosCAD Line Types. In this swatch
library, all ArtiosCAD design line types have been predefined.

Include a copy of **** ARD

You can choose to include a copy of the ARD file that was loaded in the lllustrator document that is
closest to the selected objects. The resulting ARD file will contain the selected objects AND what isin
the CAD layers in lllustrator.

Remove lines

It is possible to remove some lines of the original ArtiosCAD file. This is meant to modify cutout
windows. Do not attempt to remove fold lines with this tool. If you do this, the original fold angles will be
lost.

Place this ArtiosCAD file in the document

If you switch this option on, the resulting ARD file will be placed in the lllustrator document. It will
replace the Structural Design file that was loaded originally.
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5.3.3.
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Preview

In the preview window, you see a preview of what will be saved. You can highlight the selected contours
by toggling on Highlight Selection. You then see the distinction between the contours that are newly
added to the resulting ARD file and those contours that come from the original ARD file.

If you click Export, you can set the name and location for the file to be saved.

If you have an ArtiosCAD file loaded in your Illustrator document, the software suggests as file name
the name of the loaded ArtiosCAD file followed by _copy.

We recommend you not to overwrite the original ARD file as some functionality of the ARD file will be
lost: graphics layers are not copied and it will not be possible to rebuild the created ARD file and text
will be contourized.

{,] Note:

Placed EPS objects and/or pixel-based objects cannot be copied to an ARD file. The fill color of
the selected contours is not maintained in ArtiosCAD. Rather, the stroke color of the contour
determines the line type in ArtiosCAD. If the selected contour is in the Main Design layer, the
pointage of the contour will be 2. In all other cases, the pointage will be 0.

ArtiosCAD - Copy to Clipboard

{,] Note:

This function is only available on PC.

It can be found on the Edit menu:

ArtiosCAD - Copy to Clipboard copies the selected contours to the Windows Clipboard. They can
directly be pasted into ArtiosCAD. If you have the same ArtiosCAD workspace open in ArtiosCAD
and have not modified it since opening it in lllustrator, when you paste the contents of the clipboard
into ArtiosCAD, they use the same placement as was used in lllustrator. This function is useful for
ArtiosCAD users who need shapes from the graphics to be added to the box design.

Copy to Clipboard also offers you the possibility to add the ARD file that is currently loaded in the
lllustrator document that is closest to the selected objects. Keep in mind that graphics layers are not
copied. The resulting ARD file is also not rebuildable and text will be contourized.

ArtiosCAD - Copy to Clipbos

[ Include a copy of Pasta.ard

araphics layers are not copied, Rebuilding
the design will nat be possible.

)4 i_ance|




ESKO

Esko Data Exchange for Adobe lllustrator

Note:

Placed EPS objects and/or pixel-based objects cannot be copied to an ARD file. The fill color
of the selected contours is not maintained in ArtiosCAD. The stroke color of the contour
determines the line type in ArtiosCAD. If the selected contour is in the Main Design layer, the
pointage of the contour will be 2. In all other cases, the pointage will be 0.

5.3.4. Relationship between stroke color in lllustrator and line type in
ArtiosCAD

If the contours are stroked with a swatch color with an ArtiosCAD line type name (e.g. cut, crease),
then the corresponding items in ArtiosCAD will have the corresponding line type. For example, if you
give your contour a stroke color with as name 'Annotation’, the contour will be in line type '‘Annotation’
in ArtiosCAD. If the name is not an ArtiosCAD line type name, the contour will be a cut line. For
convenience, a swatch library ArtiosCAD Line Types is included with the plug-in. You can display the
swatch library by selecting Window > Swatch Libraries > ArtiosCAD Line Types. In this swatch library,
all ArtiosCAD design line types have been predefined.

5.3.5. How to add a cutout window to an existing ArtiosCAD file?

1. Openorplace an ARD file.

If you also have Studio Designer, you will see a 3D view of your folded box in the Studio window.

x
Studio

Expert_Design.ard ~ Custom - E @ E

@ @ 1part No Selection

Quality: = Designer Visualizer
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2. Create and select the cutout shape that you want to add to the ArtiosCAD file.
3. Choose File > Structural Design > Export Selected Objects to ArtiosCAD File.

The Export Selected Objects to ArtiosCAD File appears.

Export Selected Objects to ArtiosCAD File

Preview
ArtiosCAD File

Save selected objects in:

© Main Design Layer

(O Annotation layers based on Adobe lllustrator layers

() Layers based on ArtiosCad Line Type swatches

Include a copy of Expert_Design.ard

Graphics layers are not copled. Rebullding the design will not
be possible.

Remove Lines...

Place this ArtiosCAD file in the document

The current ArtiosCAD file will be replaced by this saved file.

& Highlight Selection ( cancet ) (Export.. )

4. Do one or more of the following:

« Save the selected objects in the Main Design Layer.
« Include a copy of the original ARD file.
+ Place this ArtiosCAD file in the document.

For more information on the different options, please refer to Export Selected Objects to ArtiosCAD
File on page 70.

5. Click Export.

The selected objects are saved in the Main Design Layer. They get the cut line type (which is

the default if you did not specify a swatch with as name an ArtiosCAD line type). Apart from the
selected objects, the original ARD file is copied in the resulting ARD file and the resulting ARD file is
immediately placed in the lllustrator document. If you have Studio Designer, you will automatically
see the ARD file with the cutout folded in 3D:
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®
Studio
v BEE®

Expert_Design_copy3.... »~ Custom

@ @ 1part No Selection

Quality: = Designer Visualizer

5.3.6. How to modify a cutout window in an ArtiosCAD file?

1. OpenorPlace an ARD file that already contains a cut-out window.
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If you also have Studio Designer, you will see a 3D view of your folded box in the Studio window.

x
Studio

~ Custom = E @ @ @

Carrycase_cutout.ard

@ @ 1part Mo Selection

Quality: = Designer Visuallzer

b
L
]
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2. Create and select the new cutout shape that you want to add to the ARD file.

U,

3. Choose File > Structural Design > Export Selected Objects to ArtiosCAD File.
The Export Selected Objects to ArtiosCAD File appears.

Export Selected Objects to ArtiosCAD File

Preview
ArtiosCAD File

ﬂ Save selected objects in:

© Main Design Layer
@ () Annotation layers based on Adobe lllustrator layers
() Layers based on ArtiosCad Line Type swatches

Include a copy of Carrycase_cutout.ard

Graphics layers are not copled. Rebuilding the design will not
be possible.

Remove Lines...

Place this ArtiosCAD file in the document

M The current ArtiosCAD file will be replaced by this saved file.
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In the preview window you notice that you do not get the desired result. We need to remove the
original cutout window.

4. Click Remove Lines.

The Remove Lines dialog appears.

Export Selected Objects to ArtiosCAD File

Al

Click a line to remove or restore it:

(N
(2 N

AN

Press spacebar+3 and click to zoom In. Press spacebar+ 3+ and click to zoom out. Press spacebar and drag to pan.

( Cancel )( 0K )

Fit In Window

[[] Hide New Lines

5. Inthis dialog, you can select the lines you would like to remove. It will not be possible to select the
new lines. You can choose to hide the new lines by enabling Hide New Lines.

6. Clickand drag arectangle around the original cutout window.

This window will be grayed out. This means that it will be removed in the final ARD file.
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Export Selected Objects to ArtiosCAD File

Nl

Click a line to remove or restore it:

(N
2 N

SEN

Press spacebar+3 and click to zoom In. Press spacebar+¥ +°C and click to zoom out. Press spacebar and drag to pan.

Fit In Window
Hide New Lines ( Eance ) o )

7. Click OK.

This bring you back to the Export Selected Objects to ArtiosCAD File dialog. In the preview window
you notice that the original cutout has been removed.

Export Selected Objects to ArtiosCAD File

Preview
ArtiosCAD File

H Save selected objects in:

© Main Design Layer
ﬁ () Annotation layers based on Adobe lllustrator layers
() Layers based on ArtiosCad Line Type swatches

Include a copy of Carrycase_cutout.ard

Graphics layers are not copled. Rebullding the design will not
be possible.

Remove Lines...

Place this ArtiosCAD file in the document

M The current ArtiosCAD file will be replaced by this saved file.
C et st Con ) Q2D

8. Click Save As.
9. Specify afile name in the Save As dialog.

The software suggests the name of the loaded ArtiosCAD file followed by _copy.
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10. Click Save.
If you have Studio Designer, you will automatically see the ARD file with the new cutout folded in 3D.

x
Studio

Carrycase_cutout_cop.. ~ Custom ~ E @ E @
(@) (® 1part Mo Selection
Scene Seftings: Custom v
Quality:  Designer Visualizer
{
\\
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/
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6. The Page Box Plug-in

6.1. Introduction

Esko Data Exchange for Adobe lllustrator

Page Boxes are used to define the outside borders and margins of your document, and it is used in the
Esko Software Suite workflow environment.

Page Box definitions are saved as part of the Illustrator file used by the plug-ins Shuttle and

PowerLayout Client.

Page Boxes are not taken into account when printing directly from Adobe lllustrator, nor are they
exported when exporting to a non-native format via standard Adobe plug-ins. They do not appear as
objects in the Layers palette.

You can find the Page Box plug-in in Window > Esko > Trim Box and Media Box

The Page Box plugin can work in two modes:

» Trim Box and Media Box (defining only those two page boxes). See Trim Box and Media Box on page

81

« AllPage Boxes. See All Page Boxes on page 85

You can switch mode by selecting Switch to [mode] from the fly-out menu.

6.2. Trim Box and Media Box

L1
(2
{
L
(¢
\
(s
L

.

Trim Box and Media Box

Trim Box (Borders):

Slze: Custom
Width: 675,767 mm
Height: 850,603 mm
Ftt: ] FQ

Media Box (Margins):

Top: o Omm

Z omm

o

Ftto: ] FQ
Artboard:
Fit to: ]

Bottom:

G Orientation:
B ®

Right: Z 0mm

ca

10
Switch to All Page Boxes L

Fit Trim Box to Artboard
Fit Trim Box to Artwork

Fit Trim Box to CAD

Fit Media Box to Artboard
Fit Media Box to Artwork

Fit Media Box to Bleed/CAD

Fit Artboard to Trim Box
Fit Artboard to Media Box

+ Use Transform Bounds

Move Trim Box and Media Box...
Delete Trim Box and Media Box

1. Trim Box Size: Select the size from the dropdown list.
2. Trim Box Width/Length: Enter the Width/Length if you want a custom size.
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[ ( ] Tip:

The units are defined in the lllustrator preferences.

. Trim Box Orientation: Select the orientation: portrait/landscape.

E ] Note:

When the Trim Box is being dragged or Width or Height editboxes edited, the radio buttons
Portrait/Landscape flip automatically so that Landscape is active whenever Width > Height
and Portrait whenever Width < Height.

. Fit Trim Box to

) IEI Fit Trim Box to Artboard

) Fit Trim Box to Artwork
) Fit Trim Box to Selection

) Fit Trim Box to CAD

. Media Box (Margins) enter the top, bottom, left and right values.

[ ( ] Tip:

The units are defined in the lllustrator preferences.

. Fit Media Box to

) IEI Fit Media Box to Artboard

) Fit Media Box to Artwork
Fit Media Box to Selection

Fit Media Box to Bleed / CAD (when no bleed was defined the cad will be taken as reference)

. Fit Artboard to

+ Fit Artboard to Trim Box
« Fit Artboard to Media Box

. Show Trim Box and Media Box: To display or hide the trim Box and Media Box, use this toggle.
. See more page boxes: In case page boxes other than Trim and Media box are defined, this link will

open the All Page Boxes version of the palette. See All Page Boxes on page 85

10. Trim Box and Media Box dropdown menu

« Switch to All Page Boxes. see All Page Boxes on page 85

« Fit Trim Box to Artboard
« Fit Trim Box to Artwork
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Fit Trim Box to Selection

Fit Trim Box to CAD

Fit Trim Box to Crop Area

Fit Media Box to ArtBoard

Fit Media Box to Artwork

Fit Media Box to Selection

Fit Media Box to Bleed / CAD (when no bleed was defined the CAD will be taken as reference)
Fit Media Box to Al Bleed Box

Fit Artboard to Trim Box

Fit Artboard to Media Box

Use Transform bounds: if this option is enabled, TrimBox/MediaBox will respect as they are
defined in Adobe lllustrator. If disabled, TrimBox/MediaBox will respect visible bounds.

Move Trim Box and Media Box ... open the 'Move Trim Box and Media Box' interface
Delete Trim Box and Media Box

The figure below illustrates the Trim Box (borders) and Media Box (margins) of an output document as
interpreted on an Esko system. The full black line represents the borders(corresponding to one of the
above options) while the dotted black line indicates the margins of the document:

6.2.1. Moving and Scaling Trim Box and Media Box

To move or change the size of the Trim and Media Boxes, you can either

« Select the Trim and Media Box Tool from the Al tool palette.

Use the Trim and Media Box to click and drag the Trim and Media Box.

« Select the Trim and Media Box Tool from the Al tool palette.

ALT +drag = scale from the center out

SHIFT + drag = constrained scaling
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ALT + SHIFT + drag = constrained scaling from the center out

" \'ﬁ Hand Tool (H)
D Print Tiling Tool C
K | Trim Box and Media Box %

&€

OR

Select a preset from the drop down menu. OR

Use the numeric input field. The numeric input field appears when you select Move Trim Box and
Media Box in the dropdown menu.

Maove Trim Box and Media Box

Distance

Herizental: 0 mm -m

Vertical: 0 mm
[ Preview

(5 Tip:
Double-clicking Trim and Media Box tool in toolpalette opens the 'Move Trim Box and Media
Box' dialog.

OR

You could use one of the “fit to” options (to Artboard, artwork, selection, cad or crop area).

Tip:

The units are defined in the lllustrator preferences.
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6.3. All Page Boxes

Using the All Page Boxes mode, you can set all 5 page boxes: Media Box, Crop Box, Bleed Box, Trim Box

and Art Box

1]

(

¢

1. Mediabox: thisis the page format

2. Crop box: includes the Bleed box and all marks.

3. Bleed box: defines the trimmed page plus the bleed.

4. Trim box: this is the net document format.

5. Art box: the Art box can be used to specify any section of the page.

You can see the dimensions of all Page Boxes in the Page Box list. You can

1. SelectaPage Box in the list. Its details will be shown in the bottom part of the dialog.
2. Enable(or disable) the specific page box by enabling the Set[...] Box option.

3. Enter the offset, width and heigth. You can click the button to swap width and height. In the Size
dropdown, you can select any of the preset sizes.

4. Click one of the Fit to buttons to fit the selected page box respectively to the ArtBoard, Artwork,
Selection or CAD.

5. Use the Show All Page Boxes to show or hide all Page Boxes in your job.
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b 44
All Page Boxes =
Page Box X ¥ Width Height
Media Box O mm 0 mm A50 mm 350 mm
U
Trim Box 5 mm 5 mm A0 mm 340 mm
Detalls Trim Box
‘ 2 Set Trim Box
o X Bmm W: 340 mm
3 zo@ i
¥: 5mm H: 340 mm
Slze: Custom ot
4
L Fitte: [ | e
' 5 Show All Page Boxes
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7. The Inspection Setup Plug-In

The Inspection Setup Plug-In allows you to define Inspection points or Inspection boxes in your job.

For each of these Inspection points, you will see the Lab value and DeltaE. For every Inspection box,
you can set the Profile. Inspection points and boxes will be exported, e.g. to be used in an Inspection
Systemininline presses. This Inspection System will warn if the values measured at a specific position
are more different from the entered Lab values than the allowed deltaE, or if the Inspection box or
Dynamic Art box doesn't match the defined profile.

The plug-in consists of

the Inspection Setup tool

o

, under the Eyedropper tool in the toolbar

« the Inspection Setup palette, which can be opened by selecting the Inspection Setup tool, or by
adding an Inspection point.

x

Inspection Setup

w Inspection Points

Default dE: : 2 CIELAB Delta E (Classic) o
X Y L a b dE
2 11,617 mm 76,699 mm 393 -110 -27.0 2
3 43,245 mm 70,616 mm 73.8 16.0 76.0 2
Tl
w inspection Boxes
Default Profile: Warning
Profile
w Dynamic Art Boxes
Default Profile: Warning

o9 Profile

7.1. Adding and changing Inspection points

The Inspection Setup palette shows all the Inspection points, indicating the coordinates (distance
from the top left corner of the trim box), Lab value and default deltaE value.
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Select the Inspection Setup tool from the Illustrator toolbar and click in the job to insert a
new Inspection point.

The Inspection point will be visible in the job, with its number next to it.
« SelectanInspection point in the palette to highlight the corresponding Inspection point on the
lllustrator job. You can select multiple Inspection points

. e

Select one or more Inspection points and click the delete button ™
points
» You can manually change the Lab and deltaE value for every Inspection Point.

to delete the Inspection

g |
Click the Refresh button ™" to update the Inspection Point list.
« You can move an Inspection point in two ways:

+ Click within the Inspection point, and drag it to the new location
« Inthe Inspection Point list, change the coordinates for the Inspection point.

7.2. Adding and changing Inspection boxes

The Inspection Setup palette shows all the Inspection boxes.
Select the Inspection Setup tool {E} from the Illustrator toolbar and click and drag in the job to
insert a new Inspection box.

The Inspection box will be visible in the job, with its number next to it. When creating a new
Inspection box, the Default Profile is used

» Select an Inspection box in the palette to highlight the corresponding Inspection box on the
[llustrator job. You can select multiple Inspection boxes.

Select one or more Inspection boxes and click the delete button ™
boxes
« You can manually change the Profile.

to delete the Inspection

« You can move or change an Inspection box in different ways:

« Click on the center point of the Inspection box, and drag it to move the Inspection box to a new
location
« Click one of the 8 handles on the Inspection box, and drag to modify the Inspection box

7.3. Dynamic Art Placeholders

The Dynamic Art section of the Inspection Setup palette shows all Dynamic Art placeholders defined in
the job.

« Enable the checkbox in front of a Dynamic Art placeholder to use it as an Inspection box.

When adding a Dynamic Art placeholder, the Default Profile is used
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« SelectaDynamic Art placeholder in the list to highlight the corresponding Dynamic Art placeholder
on the lllustrator job. You can select multiple Dynamic Art placeholders

« You can manually change the Profile.
« Disable the checkbox in front of a Dynamic Art placeholder to stop using it as an Inspection box.

7.4. Import and Export

When exporting Normalized PDF, Inspection points and boxes added to a job are saved in the PDF file,
and these Inspection points and boxes will be recognized by Packadge and Automation Engine.

Also, when opening a Normalized PDF from another Esko product (such as PackEdge), the Inspection
points and boxes information stored in the PDF document will be shown in the Inspection Setup
palette.

i = ] Note: Dynamic Art placeholders are not saved as such in Normalized PDF. The selected
Dynamic Art placeholders will be exported as "Inspection Box". If you import the Normalized
PDF in Adobe lllustrator again, or open the Normalized PDF file in e.g. Packedge, these
Dynamic Art placeholders will be shown as Inspection Boxes
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8. Messages

The Messages plug-in is included with all Esko DeskPack plug-ins.

It displays the information, warnings and errors from all the other DeskPack plug-ins, and tells you
which plug-in generated them.

You can filter the messages you see when the Messages palette is open, and clear or save all messages
if you need to.

8.1. The Messages Palette

The Messages palette pops up automatically when another DeskPack plug-in generates a warning or
an error.

You can also open it from Window > Esko > Messages.

. ““
Messages =
Message Plugin Time ~
A Barcode requires 14 digits. Dynamic Barcod... 15:04:08
@ Check digit '0' has been added. Dynamic Barcod... 15:03:32
/b, Ccorrect code should be *1234567088888". Dynamic Barcod... 15:03:32
/b check color used. Dynamic Barcod... 15:03:19
@ Check digit has been corrected 1o '0'. Dynamic Barcod... 15:03:02
/A Correct code should be ‘12345670, Dynamic Barcod... 15:03:02
@ Check digit '0' has been added. Dynamic Barcod... 15:02:51
/b, correct code should be *12345670", Dynamic Barcod... 15:02:51
¥ /A Font HelveticaNeusLTStd-Bd Is missing Inspection Setup 14:58:56
b g’i\ Font HelveticaMeueLTStd-Reman Is missing Inspection Setup 14:58.56
Extra Info: Check digit '0* has been added. Show: All

This palette shows you:

A
the message’s severity ( @ information, “** warning or ﬂ- error),
« the message’s text in the Message column,
« which Plugin generated the message,

« the Time the message was generated at.

Tip: You can click the column headers to sort the messages, and drag the columns horizontally
to adjust their widths.

You can also use the palette to get extra information and / or select the objects that generated
warnings or errors:

« click amessage to display extra information at the bottom of the palette.
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? ,"i“, Font HelveticaNeueLTStd-Bd Is missing Inspection Setup 14:58:56
¥ & Font HelveticaNeueLTStd-Roman |s missing Inspection Setup 14:58:56
Extra Info: Font HelveticaWeueL TStd-Roman Is missing. Text will use font Show: All

MyriadPro-Regular. This may change the text flow.

click the triangle in front of a message to see the list of objects it relates to.

hd & Font HelveticaNeuelLTStd-Bd Is missing
ENERGY COMNSERVING
APl SERVICE SN

click one of the objectsin the list to select it in the file.
double-click that object to select it and zoom in onitin the file.

double-click the message to select and zoom in on all objects it relates to in the file.

8.2. Filtering the Messages

You can show or hide certain types of messages using the palette’s fly-out menu.

To hide:

« allinformational messages, select Hide Info Messages in the fly-out menu,
- allwarnings, select Hide Warning Messages,

- allerrors, select Hide Error Messages.

To show them again, select either:

+ Show Info Messages,

« Show Warning Messages,

+ Show Error Messages.

To only show the last message, select Show Last in the fly-out menu.
To show all messages again, select Show All.

When showing all messages, you can see Show: All at the bottom right of the palette.

When filtering messages (for example filtering out the warning messages, or showing only the last
message), you can see Show: Filtered at the bottom right of the palette.

8.3. Saving the Messages

To save all messages in a text file:

1.
2.

Select Save Messages as... in the fly-out menu.
In the browser window that opens, choose the name and location to use for saving your file.
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8.4. Clearing the Messages

« Toremove all messages from the Messages palette, select Clear in the fly-out menu.
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9. Esko Document Setup

By choosing File > Esko Document Setup you can open the Esko Document Setup dialog.

The settings made here are saved in the Esko XMP Document Information.

9.1. Distortion

The vertical and horizontal distortion value is saved with the document and used by Esko RIPs when
generating the final output. It allows to compensate for distortions in certain printing methods, e.qg.
flexography. On mounting a flexo plate on the press, it is stretched out in one direction. By making the
output slightly smaller than needed (e.g. 95%), we compensate for this distortion.

Values for vertical and horizontal distortion is limited to 90% - 110 %.

9.2. Screen Registration

The Screen Registration parameter allows to choose

(]

Below a schematic representation of a Repetition with (left)and without (right) resetting the screen
origin for every one-up.

if the RIP should reset the screening origin for every one-up

or keep the same screening origin for the complete document

93



Esko Data Exchange for Adobe lllustrator

ESKO

vewvwvewwewwew'
0008000008
0000000000
0000000008

BHEHH

LA A A A A A A A & A
11131211111
POOOOOOOOO(
2000 SO00OO!(
P000OS000OO(
00000000 O(
POOOOOOOOO(
44l dddddld

9000000(

00000801

(T I T T T 71T

L

94



ESKO

Esko Data Exchange for Adobe lllustrator

10. Annotations

With the Annotations plugin, you can view .xfdf annotations generated by Global Vision and
WebCenter.

Since version 16, Global Vision SDK has been integrated in Esko's Automation Engine, allowing several
types of Global Vision Check tasks to be run.

The output of a Global Vision Check is an .xfdf file, highlighting the found errors and problems on the
document.

The .xfdf file can be loaded (see Loading XFDF files on page 95)and the annotations are shown in the
Annotations palette (see The Annotations palette on page 95).

10.1. Loading XFDF files

Whenever a file is opened in Adobe lllustrator, the Annotations plugin will try to find the corresponding
XFDF file to open.

« ForGlobalVision annotations, the supported file types are Adobe PDF, Normalized PDF and Adobe
[llustrator file

« For WebCenter annotations, the supported file types are Adobe PDF, Normalized PDF, Adobe
lllustrator file, Adobe lllustrator ZIP file and ARD.

If for example a file "sample.pdf" is opened, the plugin will search for the corresponding .xfdf file in the
following locations, in the specific order shown below.

1. .view/sample.pdf/*.xfdf

2. .view/sample*.xfdf

3. sample*.xfdf

4. . /sample wcr.xfdf for WebCenter annotations

10.2. The Annotations palette

The Annotation palette will show all Annotations found in the .xfdf file. You can open the palette by
choosing Window > Esko > Annotations.
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X 11

Annotations

[l :: I ad T @

1 |l Barecode {Jonathan Hau): 2015-10-07 15:27:24

WValue Left/Bottom: 117420
Value Right/Top: 111854
Type: Pharma Code
Grade: C

2 |l Barcode {Jonathan Hau): 2015-10-07 15:27:24

Value: 814624442257
Type: UPC-4
Grade; B
Magnification: 111.00 %
Bar Width Reduction: 0.0 mm

Zoom

Show only selected annotation

There are different types of annotations: Barcode, Braille, Spell Check, Artwork, Text Compare and
WebCenter annotations.. You can browse to them by clicking the buttons on top of the palette.

. Note: If the document only contains WebCenter annotations, you will not have any filtering
“=% options. If your document only contains Global Vision annotations, the "WebCenter" button will
be hidden.

For every issue found, an entry in the list is shown. Some of these annotations have text content, while
others can have an image preview, showing the difference between the actual artwork and how it
should look.

If Show only selected annotations is enabled, only the annotations you select in the list will be
highlighted in your job using a colored rectangle. Otherwise, all annotations in the job will be
highlighted.

If Zoom is enabled, selecting an annotation in the list will automatically zoom in on the issue.

Multipage PDF files with Annotations

96
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If you import a multipage Normalized PDF, the plugin knows what page you imported, and only the
Annotations for that specific page will be shown.

If you import a multipage PDF as Adobe PDF, the plugin can't know what page you imported. In that
case, the Annotation palette will have a dropdown at the bottom of the palette, to decide for what page
you want to load the annotations.

Note: Multi-page annotations is not supported for WebCenter annotations

10.4. Editing WebCenter annotations

You can edit existing WebCenter annotations or create new annotations, and save them back to
WebCenter.

To create new annotations, you can use the Annotation Tool. See Creating new annotations using the
Annotation Tool on page 98

For every annotation (or reply), you can use the dropdown menu to modify the annotation.

x L1

Annotations

A 1 unsaved annotation.

1 () ADMIN [ADMIN): 2071B8-05-31 09:25:54 -
is color correct ?
2 —) ADMIN (ADMIN): 2018-05-31 09:26:21 -
spread 3mm v’ Accepted |
% "Completed": ADMIN [ADMIN) X Rejected
3 [=] ADMIN (ADMIN): 2018-05-3109:27:21 © cancelled v
correct text & Completed
None
& Edit
lil Delete
Zoom a Copy
Show enly selected annotation - Reply

« Select Accepted. Rejected, Cancelled, Completed, or None to change the status of the annotation
accordingly.
« Select Edit to change the text of an annotation, or to move or resize the annotation.

You can click and drag the annotation to move it, or you can click and drag any of the handles on the
annotation to resize it.

The dialog will be extended, offering text editing options.
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1 (O ADMIN (ADMIN): 2018-05-31 09:42:33 v
TITITITRT.IT RS

is color correct ?

Cancel Save

Note: Clicking the Save button will store your changes in the (local) annotation, but will
“==% NOT save the annotation back to WebCenter. The annotation will be an "unsaved annotation’
until you use Save Annotations from the fly-out menu. See below.

« Select Delete to remove the annotation.

« Select Copy to copy the content of a comment or annotation. This will open the Copy to Clipboard
dialog. Select the text you want to copy, and click Copy.

« Select Reply to add a reply to an annotation.

Note: You can only reply to an annotation, not to a reply.

« If there are unsaved changes in the annotations, the Annotations palette will show a warning.

Choose Save Annotations from the fly-out menu in the Annotations palette to save the new or
modified annotations back to WebCenter. See Updating and Saving Annotations on page 99

10.5. Creating new annotations using the Annotation Tool

Using the Annotation Tool you can create new annotations.

1. Click the Annotation Tool in Adobe lllustrator's tool box.

|:|‘ » [] Rectangle Annotation Toaol
(O Oval Annotation Tool
~~ Line Annotation Tool
= Arrow Annotation Tool L
"\ Freehand Annotation Tool
= Highlight Annotation Tool

< Note Annotation Tool

2. Select the type of annotation you want to create.
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3. Click or drag where you want to create the annotation.
4. Inthe Annotations palette, enter the text for the annotation

q D ADMIN (ADMIN): 2018-06-05 14:54:24 b

TITHTFANT. T

Delete Save

5. Click the Save button to store your annotation text, or click Delete to remove the annotation.
6. If necessary, repeat the previous steps to create additional annotations.

Choose Save Annotations from the fly-out menu in the Annotations palette to save the new
annotations back to WebCenter. See Updating and Saving Annotations on page 99

10.6. Updating and Saving Annotations

Each annotation contains a time stamp of creation. In case the source file is modified and saved later
than the annotation, a warning icon will be shown on top of the palette, indicating the annotations
might be out of sync with the document.

Also when you edit Annotations (see Editing WebCenter annotations on page 97) or create new
annotations (see Creating new annotations using the Annotation Tool on page 98), a warningicon is
shown, indicating that these annotations are unsaved.

You can use Save Annotations from the fly-out menu to save all unsaved annotations to WebCenter.

You can use Update Annotations from the fly-out menu in the Annotations palette to get the latest
annotations from WebCenter.

If you select Update Annotations while your document contains unsaved annotations, a warning will
be shown, asking if you wish to save the annotations. You can select Yes to save the annotations to
WebCenter, or click No to ignore the unsaved changes and get the latest annotations from WebCenter.

E ] Note:

In case the annotations can not be loaded or saved (e.g. you are no longer logged in with
WebCenter Connector, there are no annotations available for the document, or the document
no longer exists) you will get a warning message indicating why loading or saving didn't work.

You can not save annotations, edit annotations or reply to an annotation if the Annotations
plugin is older than version 16.1.2, or if the WebCenter Connector plugin or WebCenter server is
not the latest version.
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11. Share & Approve connection

The integration of DeskPack with Share & Approve allows you to

« Upload PDF files from within Adobe lllustrator to the Esko Cloud.

« Share these PDF files with other people, either working in the same company or not.
« Request users to annotate and/or approve (or reject) the document.

» Review the Annotations in DeskPack.

« Add Annotations on the document inside DeskPack.

For more information on Share & Approve, see:

« The Share & Approve Documentation

« The Share & Approve eLearning modules

11.1. Setting up the Share & Approve connection

In order to enable the Share and Approve functionality in DeskPack, a configuration file must be saved
on a specific location.

1. Create the configuration file:

« Thefile name should be ShareAndApproveURL. txt

« The contentsis a single text line and specifies a URL:
« If youraccount resides in the clusterin the EU, use https://applink.eu.esko.cloud/
panelcomponent/panel/main

« If youraccountresides in the cluster in the US, use https://applink.us.esko.cloud/
panelcomponent/panel/main

2. Move the file to the correct location:

« OnWindows: $USERPROFILE%\Documents\EskoArtwork\DeskPack\

« OnMacO0S: /Users/Shared/EskoArtwork/Deskpack/

11.2. Connecting to Share & Approve

The first time you select Window > Esko > Share & Approve you will be asked to Sign In.

Enter your Esko ID and Password.
If you want to keep the information stored, enable Remember Me
Click Sign In

If your Esko ID is associated with multiple Esko Cloud Accounts and/or Workspaces, you will be able
to choose the Account or Workspace you want to use from a dropdown.

N
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Note: These dropdowns will not be shown if the currect document is already uploaded to
Share&Approve.

When the current document is not uploaded to the cloud, you can switch to another Account or
Workspace by clicking the Esko Cloud Account button.

11.3. Uploading the current document to Share & Approve

To upload the current document to Share & Approve:

1. If the Share & Approve pallet isn't open yet, choose Window > Esko > Share & Approve

2.
Click the Upload button. ﬂ'

3. Enter the Asset Name. By default, the name of your document is used.

4, Select the Folder on Share & Approve in which you want to upload the file. If necessary, you can
create new subfolders by clicking Create New Folder

5. Click Upload

Note: Instead of uploading your document, you can click the Share button, to combine two
actions: uploading the document as described here, and sharing. See Sharing the document on
page 103

11.4. Working with an uploaded document

If the active PDF document is uploaded to Share & Approve, the Share & Approve pane looks like this:
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» 113

Share & Approve

'B 9024_EskoWorld_CLEAN LABELS.pdf
Version 2 - File shared to cloud & & 22

o Pending

View in browser

. Add Annotation

All Users =

All Review States

Show All Show Selected Hide All

() Mo annotations found.

Lt Esko Cloud Account

Click the Upload button 6 to upload a new version of the document.

L]
Click the Permissions button ®== to open a browser window and change the permissions for the

current file.
« Click the Share button to share the document to other people, either within or outside your own

organisation. See Sharing the document on page 103
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In the Annotations section you can see and add annotations to the file. See Annotations on page
103

11.4.1. Sharing the document

1.4.2.

By sharing a document you can have users inside or outside your organisation to view, check, annotate
and accept or reject your document.

1.

2.

In the Share & Approve panel, click the Share button.

Enter the e-mail address of the user you want to share the document with. Users that are registered
to the account can be selected from the dropdown by clicking the triangle.

N -
For unregistered users, you can use the language selector to specify the language used

in the e-mail notification. For registered users, the language as defined in their profile will be used.
Enable Request Approval if you want the users to approve or reject the document.
In that case, you can add a Due Date for the approval.

When sharing the document with unregistered users, these users will receive a link to access the
file without password. The Expiration date for the link sets how long this link remains valid.

The Assets Details display the name and location of the document. This section is read only.
Click Share.

An email will be send to all selected users, containing a link to open the document in the Viewer.

Annotations

Users with whom a document is shared can view the document in the Viewer, and can add comments,
named "Annotations”. In ArtPro+ you can see those annotations and add annotations yourself.

The Share & Approve panel will show a list of all annotations, indicating the content and the user
who added the annotation

Using the dropdowns, you can filter the list of annotations based on the user, or based on the review
state of the annotation.

By default, Show All is selected, so all notes are shown in your document. Use Show Selected to
only show the annotations selected in the list, or Hide All to hide all annotations.

For every annotation, you can:
+ Enterareply

* Click the More button ° and set a State for the annotation: Accepted, Rejected, Cancelled,
Completed or None.

* Click the More button ° and Duplicate, Edit or Delete the annotation.

Note: Annotations added in the Viewer are not immediately visible in Adobe lllustrator. To load
new annotations, choose Refresh in the fly-out menu in the upper right corner of the Share &
Approve panel.
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12.1.

Esko Data Exchange for Adobe lllustrator

Esko Plug-ins Dashboard

On your Esko Plug-ins Dashboard, you can:

« See which features you use, and how often,

» Learn how many files are processed with your Esko plug-ins,
Get configurable reports for your company.

« Get personalised suggestions and complimentary training.

To build the dashboard, Esko needs to collect personal data about your plug-ins usage.

1. Open the Dashboard panel by choosing Help > Esko > Dashboard...
2. Click the Yes, | want a dashboard button.
3. Signinwith your Esko ID

More information about Esko ID can be found here

i = ] Note: If you already enabled Dashboard before, you can skip step 2 and 3.

4. Click the Go to my Esko Plug-ins Dashboard link to open the Dashboard

Opt Out

12.2.

At any time, you can opt-out and stop the personal data collection.

1. Open the Dashboard panel by choosing Help > Dashboard...
2. Click the Opt Qut button.

3. Ifyou click Opt Out, Esko stops collecting personal data, but still gathers anonymous usage data to
help us improve the product.

More about the dashboard and data collection
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Insights for you and your team

You will get a dashboard for DeskPack and/or for Studio where you can check that you are getting
the most out of your software investment. You can filter on those features that are the most valuable
to you, and keep track of how often they are used, how many files are handled, and by how many
people across your company. If your colleagues also opt in, you can also combine the datain a single
dashboard for your company.

What data is collected?
We automatically collect your Esko plug-in usage:

- Basic information about your computer (0S version, language, screen resolution, ...).
«  Yourversion of Adobe lllustrator and which Esko plug-ins are installed.
«  Which actions you perform on Esko plug-in, including some of their parameters.


https://wiki.esko.com/display/KBA/KB93520328%3A+What+is+Esko+ID+and+why+should+I+get+one
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If you opt in to the dashboard, then this usage data is tagged with your EskolD (name and email). If you
do not opt in, then this usage data is anonymous.

Either way, We do not collect information that can be used to identify your client or the designs that
you work on(such as text statements, barcodes, separation names or filenames).

Your datais protected

Your usage data will be available only to Esko and (if you opt-in) to you and to your colleagues (based on
the company code of their Esko IDs). Learn more about Esko ID and check out our privacy policy.

Help us improve our products

Sharing your usage data with Esko allows us to learn about your configuration and your use of our
products. This data enables us to focus on the features that matter the most to you.

Opt-out whenever you want

At any time, you can opt-out and stop sharing personal data. Just choose Help > Esko > Dashboard and
click the Opt Out button.
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